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About Gentran Integration Suite
Business Processes

Welcome to Business Process Modeling
The Gentran Integration Suite approach to integration centers on business process management. Business 
process modeling is the foundation of the configurability and extensibility of Gentran Integration Suite 
Using Gentran Integration Suite, you coordinate and automate the activities that make up the processes your 
company completes to do business. From advanced file translation and transport to content-based routing 
and complex integration, including human interaction, you can configure the activities you need using 
Gentran Integration Suite business process modeling features.

About Business Processes
In the business world, a business process is any goal-driven, ordered flow of activities that accomplishes a 
business objective. Invoicing, order fulfillment, and updating employee information are all examples of 
business processes. In Gentran Integration Suite, business process refers to the automated implementation 
of business objectives. 

Most Gentran Integration Suite processing activities are predicated upon defined business processes—the 
custom-designed programming instructions you provide to Gentran Integration Suite, to perform your 
required activities. The fact that you can custom create business processes in Gentran Integration Suite 
means that you control:

✦ What happens when
✦ Which Gentran Integration Suite components perform the activities
✦ What rules, constraints, or decision points play a role in the execution of the activities
✦ The degree of available visibility into processing
✦ The amount and type of data the system records about the activities
Gentran Integration Suite components and features are designed to provide a variety of options for 
configuring your activities. As a result, you often have multiple choices available when determining how to 
achieve a given goal. With so many choices, you can create business processes that are expressly suited to 
your organization’s requirements—not only to complete the required work, but also to maximize processing 
efficiency for all of your processes, streamline your ongoing maintenance tasks, and facilitate monitoring 
and tracking operations.
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Business Process Concepts
For example, some of your processes may require quick turnaround, while others may involve batch 
processing not tied to a time limit. You can configure efficient processing of both types of processes by 
running low-priority batch processes during slow periods, which frees system resources for the 
higher-priority items that run immediately. Customizing your processing activity for maximum efficiency 
keeps system resources available for enhanced management options such as archiving, data persistence and 
document tracking.

Business Process Models
Gentran Integration Suite allows you to create an automated business process using drag-and-drop 
technologies to link activities in a digital, graphic representation of the related task—known as a business 
process model. The business process model is the definition for the process, used by Gentran Integration 
Suite each time it runs the process. The activities in your business process models are carried out by services 
and adapters, represented by icons in the graphical interface. This method enables you to incorporate small 
units of reusable code into your business processes, and, at the same time, create larger units of reusable 
code specific to your business operations.

Creating business process models is the central endeavor around which your use of Gentran Integration 
Suite hinges. Think of business processes in Gentran Integration Suite as the structures by which you 
organize software components and activities to fulfill your work objectives. 

Benefits of Business Process Modeling Flexibility
Your business processes and the efficiency with which they progress are the key to your organization’s 
success. To be competitive, you must be responsive to constant change within your trading partner 
community. Changes driven by new requirements such as new data formats and communication protocols, 
new business exchanges, and a broad range of partners varying in size, type, and sophistication, mean your 
organization must be flexible enough to adapt quickly and efficiently.

By integrating activities through automated business process models, all in the form of easily reusable code, 
you increase the value of your e-business operations. As your needs change, modifying your business 
process models to keep pace is simple.

Support for Business Process Modeling
Gentran Integration Suite components and tools are designed to support the full range of standards, foreign 
languages and data types, in a user-friendly fashion. 

Graphical Process Modeler
The graphical modeling tool (the Graphical Process Modeler, or GPM) that enables you to create business 
process models using a visual, drag-and-drop palette, converts your graphic business process models into 
code, saving you the effort of writing code. Your process models are immediately executable, and the 
process development cycle time is short. 
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The primary benefits of business process definition using the model format are that you do not need direct 
developer involvement, you can create your models in a visual medium, and you can copy any business 
process model or portion of a model to use it in another process, eliminating the need to duplicate effort. 

Standards, Foreign Language and Data Type Support
The services and adapters provided with Gentran Integration Suite are developed using publicly 
agreed-upon specifications for data formats, communications protocols, workflow modeling, and security 
to maximize interoperability between systems and trading partners.

Gentran Integration Suite code base supports universal character-encoding, therefore, programs with which 
your business processes interact can be written in nearly any language. And Gentran Integration Suite 
supports virtually any file-, message- or stream-based data type.

Available Service and Adapter Components
Gentran Integration Suite provides more than 200 available services and adapters you can build into your 
business process models. This includes a host of configurable adapters ready for use in business processes 
for activities such as running legacy programs, ERP systems, Perl scripts, Java™ code, decision engines, 
defined subprocesses, or virtually any program. 

Adapters provide noninvasive integration with ERP, Supply Chain Management, Customer Relationship 
Management, other packaged applications, legacy applications, communications protocols, queuing 
solutions, and databases.

Support for High Volumes of Transactions
Depending on your task (for example, translation and routing, content-based routing, or EDI inbound or 
outbound transactions), and the standard in use (X12, EDIFACT, and so on) you can process anywhere from 
hundreds of thousands to millions of transactions per hour according to the business process models you 
create. Gentran Integration Suite provides a variety of adapters designed to support high-volume processing. 

Visibility Into Process Activities
Gentran Integration Suite enables you to view general and detailed processing information for active and 
recent business processes and service activities. Because Gentran Integration Suite interoperates with other 
enterprise system management products, you get full-spectrum transaction visibility. 

In addition to process data, you can enable document tracking for a business process so that the system 
carries tracking information with the document, and then, for monitoring and tracking purposes you can: 

✦ Track processing history of the document
✦ View transaction details related to the document
✦ Obtain processing state information related to the document
Portlets in the Gentran Integration Suite dashboard interface enable at-a-glance monitoring of your 
processing activities, and you can configure custom reports related to the operations undertaken by your 
business processes.
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What Kinds of Things Can Business Processes Do?
The strength of using the business process approach to integration is enhanced efficiency through 
automation, combined with simplified configuration of integration tasks. 

Automation and Integration
Any time you can replace manual intervention points in your business processes with automated 
capabilities, you save money. Classic examples of intervention points include exception management such 
as escalation and transaction reconciliation, error handling, and content-based routing.

Gentran Integration Suite business process modeling supports your end-to-end integration goals by enabling 
you to link vital systems and processes using services, adapters and human interaction points that you need 
to achieve your business objectives. You can embed conditions within the process flows. 

The following figure shows Gentran Integration Suite integration engine coordinating communication of 
data to trading partners. Business processes related to this scenario might involve:

✦ Transforming data (using services) from different applications so that it can be communicated to other 
systems.

✦ Moving and communicating data between different systems external to Gentran Integration Suite, 
using adapters.
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✦ Communicating data to trading partners, using adapters.

Examples
The following table provides examples of how business process models can help you to automate and 
integrate your activities:

Type of Activity Example Business Process Activities

Automating Route messages according to their content.

Configure mailbox store-and-forward services.

Support real-time request and reply processing within a process.

Build on-fault processing steps into your process models

Send alerts and notifications automatically within a process.

Gentran
Integration 

Suite
Business 
Process
Engine

Trading
Partners

Communications
Adapters

SAP R/3 
Adapter

IBM 
WebSphereMQ

Adapter

IBM 
WebSphereMQ

Messaging
System

SAP R/3
System

Relational
Database

   

JDBC
Adapter
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Business Process Concepts
In Gentran Integration Suite, a business process is a series of linked software and possibly human activities 
that accomplishes a business goal. The activities in a business process are primarily performed by 
components known as services and adapters, and are orchestrated by Gentran Integration Suite integration 
engine. 

The Business Process engine runs business processes according to the instructions that comprise your 
business process models. Technically, a business process model is defined by a single, unique BPML 
document, a .bpml file. BPML is an XML-based language used to describe (model) and run business 
processes.

Business process models are the executable tasks and instructions that make up processes. A Gentran 
Integration Suite tool called the Graphical Process Modeler, or GPM, enables you to create business process 
models by manipulating icons that represent services, adapters, and other specific instructions, in a graphical 
palette. The GPM converts the graphical representation of business processes to BPML behind the scenes.

Integrating Incorporate messaging, human interaction, and file and database activities (a set of 
services, called human interaction services, enable people to interact with a business 
process). For instance, a worker can use a Web browser to send a message, as a 
step in a business process. When the message is sent, the business process 
continues. The process could be configured to both send the message and store a 
record in a database.

Set up self-service access to information across trading partner systems.

Integrate with SNMP network management, LDAP directories, and Web services.

Integrate with diverse operating and ERP systems.

Automating and 
Integrating

Incorporate XML, EDI, and proprietary file translation, transformation and filtering.

Facilitate e-business with your trading partners for a vast assortment of transactions, 
including EDI, e-mail, data publishing, and reliable bulk file management.

Automate the integration of batch, synchronous, and asynchronous applications. For 
instance, you can integrate a legacy inventory management system with your front 
office Web-based order processing and accounts receivable invoicing systems.

Support multi-party collaboration work processes for the entire document life cycle. 
For instance, you can route data through a series of review-and-approval steps, 
allowing data modifications to be made by the reviewing parties along the way, and 
the reviewers could be using disparate systems.

Synchronize data in different internal applications or between your organization and 
your trading partners.

Type of Activity Example Business Process Activities
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The following diagram illustrates a simple business process model as it displays in the GPM:

This example is one of the predefined business process provided for your convenience with Gentran 
Integration Suite (this is the EDI deenveloping business process). The following figure illustrates the BPML 
code that is created, stored and used by Gentran Integration Suite for a business process model:
<process name="EDIDeenvelope">
  <sequence>
    <operation>
      <participant name="EDIDeenvelope"/>
      <output message="Xout">
        <assign to="." from="*"></assign>
      </output>
      <input message="Xin">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>

For more information about predefined business process models, see:

✦ Reusability of Business Processes
✦ Using Predefined Business Process Models
✦ Subprocesses

Subprocesses
Any business process can be a subprocess. The term subprocess indicates a business process that is invoked 
as part of another business process (the initiating process is called the parent process). Subprocess is an 
integral concept in Gentran Integration Suite, because building a business process once, but using it as a 
subprocess in multiple other business processes, simplifies future maintenance. 

When you modify a process model that is called as subprocess by multiple business processes, you make 
one set of modifications – in the subprocess – but all of the parent business processes use the updated 
subprocess when they run.

In this way, subprocesses work with the design concept of reusability; by identifying simple units of work 
that appear in more than one business process, and designing your subprocesses to be as generic as possible, 
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you can save a great deal of time. The following illustration shows how a subprocess fits into a larger 
business process model:

Reusability of Business Processes
Reusability is the concept related to creating business processes that can be used in multiple operations. 
Reuse is beneficial both for uniformity, which aids in troubleshooting and monitoring, and for efficient 
maintenance of your processes. For example, if you use a single business process model as a subprocess 
within many larger process models, any time you need to modify the activities in the subprocess, you need 
only update one model, and the changes are reflected everywhere the process is used. 

Predefined Business Process
A predefined business process is a business process model that is provided with Gentran Integration Suite 
and is ready to use upon installation of Gentran Integration Suite, with minimal configuration required. A 
variety of predefined business processes are available for your use. For additional information, see Using 
Predefined Business Process Models.

Business Process Instance
Because a business process model is the definition of a process, each time Gentran Integration Suite 
executes that specific set of instructions, it runs what is referred to as an instance of the business process 
defined in the model. This distinction enables you to differentiate between multiple executions of the same 
business process model, which is imperative for monitoring and troubleshooting your processing activities. 
Gentran Integration Suite identifies each instance with an instance ID in the interface.

Receive Order Sort Order Translation 
Needed?

Hand-off to 
Order 

Processing

Translate Order

Process A: Customer Order Process

Process B: Order 
Translation Sub-Process

No

Yes

Inbound order 
initiates Process A

Process A determines translation is 
needed and initiates Process B
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Service Configurations in Business Process Models
Services and adapters are software components that do work (adapters are a type of service). Business 
processes call services and adapters to do this work, but you must configure them for use before you can 
include them in your business process models.

Services exist on two levels in Gentran Integration Suite: as service types and service configurations. 
Service types are the services installed with Gentran Integration Suite—these are service definitions 
provided for you to copy and configure according to your needs. 

The act of copying and configuring a service type creates a service configuration. You must create service 
configurations in order to use services with your business processes. A service configuration is a unique 
definition of a service or adapter type for which you have specified specific parameters. When you create a 
service configuration, you save it with a unique name.

Business Process Version
Before using business process models, you must check them into Gentran Integration Suite, which saves a 
copy of each file you check in. A business process version is one of these copies of a business process model 
checked in to Gentran Integration Suite. The saved versions enable you to revert to using an older copy of 
a business process model if the need arises, and to compare different iterations of your process models.

Business Process Model Components
When you create business process models, you link Gentran Integration Suite components needed to carry 
out the required tasks for your business objective, creating a graphical representation. All components are 
represented by icons in the GPM. The following table describes components used in business process 
modeling:

Business Process 
Component

Description

Service A component you can configure in a Gentran Integration Suite business process to carry 
out an activity. The Translation service, for example, performs data translation within a 
business process.
An adapter is a type of service that communicates with external systems to move data in 
and out of Gentran Integration Suite. For example, you can use the File System adapter as 
part of a business process to collect files. 

Adapter See Service, above.
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Business Process Flow
Gentran Integration Suite architecture centers around the execution of individual services according to your 
process models. At the core of the system architecture is the integration engine, which executes the services 
and adapters needed to achieve your business goals and enable visibility into processing activity. Each step 
in a process model either initiates an activity in the process flow, is initiated and runs during a process flow, 
or ends a process flow. 

Gentran Integration Suite may start business processes in different ways:

✦ According to a user-defined schedule
✦ In response to an activity, such as the placement of a file into a specified folder (you can configure a 

single input adapter in Gentran Integration Suite to work outside of a business process and to 
dynamically select the appropriate process to start when it receives a file)

✦ A user manually starts a process
At each step in a business process, the integration engine calls the indicated service and one of the following 
ensues: 

✦ Services run within Gentran Integration Suite. 
✦ Adapters call third-party applications to perform activities outside of Gentran Integration Suite. 
✦ BMPL activities configured in the business process model provide instructions to the integration 

engine regarding the process flow, such as start and stop, assign a specified value in the process data, 
run specified activities simultaneously, and so forth. 

When an activity completes, the integration engine progresses to the next step in the business process.

At each step in a business process, Gentran Integration Suite saves a copy of work flow context (WFC) data, 
which records the state of the business process from service to service. The WFC contains the document 
being manipulated by the business process and is where each service reports any errors. 

Flow Complexity
A business process can flow as a simple linear configuration or contain one or more:

✦ Decision points requiring human or system determination of the next steps in the process

BPML activity Performs a BPML function. BPML activities enable a business process to perform an 
operation (such as invoking a service), providing control of the flow of data through a 
business process.
Think of BPML activities as instructions built into a process. The BPML activity called the 
Choice activity, for instance, allows you direct the flow of data in a process into different 
activities according to the result of a decision. For example, you can create a decision point 
that routes high-volume invoices to a manager while passing smaller invoices on for 
immediate processing.

Business Process 
Component

Description
Sterling Commerce, Inc. 12



Business Process Concepts
✦ Subflows or nested activities
✦ Loops (repeating activities)
An example of a simple business process is fire-and-forget publishing of a business event to a group of 
interested participants. The steps in the process would be triggering the process and the subsequent 
publishing of the event to the interested parties. 

A complex business process might require multiple interactions among many applications in a 
start-and-stop, request-response mode, along with human interaction, occurring over a long period of time

The following figure illustrates the tasks in a simple process containing a decision point (a diamond 
represents a decision point):

In this figure, the business process may include the following activities:

1. Receive a purchase order (PO). In a likely usage scenario, Gentran Integration Suite receives the 
document through an adapter configured to operate outside the context of a business process. 
According to the content of the document, Gentran Integration Suite determines which business 
process to start and starts the first service in the process by placing the message or document and other 
appropriate process state information on a queue for the appropriate service in the selected business 
process.

2. The appropriate service retrieves the initial business process state information from the queue (PO 
Received, in the figure depicted above) and processes the next step in the business process.

3. A service, according to rules assigned to a Choice activity in the business process model, reviews the 
PO amount to determine whether the PO is more than or less than $500.

4. If the amount is less than $500, an adapter sends the modified business process state information, with 
the data, to a specific application for PO request processing (this likely involves initiating another 
process).

5. If the amount is greater than $500, an adapter sends the modified business process state information, 
with the data, to a specific application or human interaction service for a manager to further review the 
request.

For more information about structuring business process models, see Organizing Your Business Process 
Models on page 27.

Business Process Management Activities
Single business process models generally represent only a portion of an entire business process solution. 
Typically, users configure multiple business process models to work together to accomplish each business 

Total > 500
No

Yes
PO Received

Process Request

Send to Manager
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goal. Gentran Integration Suite is equipped to manage complex operations, but following good design and 
maintenance practices also helps to ensure that Gentran Integration Suite is optimized for best performance. 

Because business process models are likely to have decision points and interrelated subprocesses, creating 
business process models may be complicated by the need to manage many business processes at the same 
time. Often, a business process shares aspects of other business processes, such as access to the same 
software applications, use of the same B2B processing standards, and use of the same resources in Gentran 
Integration Suite. 

Managing your business process models involves the following tasks:

✦ Planning the most efficient processes to achieve your business objectives
✦ Determining Gentran Integration Suite components needed to complete the tasks in the processes
✦ Configuring business process model components
✦ Creating business process models
✦ Testing process models
✦ Implementing your business process models in Gentran Integration Suite
✦ Modifying business process models as your changing needs require them to grow, shrink, change, 

merge, and split
✦ Keeping records of the process models you create, use, and modify, for reference
Your business process models are Gentran Integration Suite resources, meaning, you can save them to an 
offline directory and import and export the files as needed from one copy of Gentran Integration Suite to 
another. 

Your business process management goal is to maximize the usefulness and efficiency of the process models 
you create, while minimizing the work involved in creating and maintaining them. To help minimize set-up 
time, Gentran Integration Suite includes a number of predefined business process models that you may be 
able to use. In addition, follow Gentran Integration Suite best practices for business process creation so that 
your processes run at the maximum system performance possible for your activities.

For detailed information about planning and creating your business process models, see Planning Your 
Business Process Models. 
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Introduction to Planning Process Models
Careful planning is the key to developing business process models that both process efficiently and 
minimize your ongoing process model management efforts. Understand your business problems in detail 
and prepare to invest the bulk of your effort in process planning and collecting related information. This will 
make creating your business process models easier. 

Much of your research may already be complete. When you outlined your Gentran Integration Suite 
implementation, you most likely worked with Sterling Commerce Professional Services to create an 
architectural design plan detailing the ways you intend to use Gentran Integration Suite, and the associated 
components and features you will employ. 

Many of the details of your architectural design plan describe the business process models needed to 
automate the execution of your processes. Use that information as you progress through the business process 
planning steps provided in this documentation. 

How to Approach Business Process Planning
Essentially, when you create business processes, you are programming Gentran Integration Suite to execute 
your desired activities. Gentran Integration Suite makes your tasks easier by providing preconfigured 
services, adapters, Web templates, and the Graphical Process Modeler tool. However, the following 
development tenets should be the foundation of your business process modeling strategy:

✦ Uniformity and reusability
Approach the creation of all business process models in the same way, with a focus on maintainability. 
A uniform modeling approach increases your opportunities to reuse processes and parts of processes 
throughout your implementation, and streamlines ongoing management of your process models as 
your needs change over time.
For more information about the concept of reusability and other terms related to business process 
modeling, see Business Process Concepts on page 12.
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✦ Performance
Understand how your implementation is designed so that you do not create process models that hinder 
performance. Your goal is to maintain acceptable levels of functionality and performance as the 
amount of work being performed in the system increases. 
As you develop your business process models, you may discover more efficient ways to perform a 
required task. For example, depending on the complexity and size of your documents, in some cases it 
may be faster to use an XML Encoder service instead of a full translation solution. 
Familiarize yourself with Gentran Integration Suite performance and tuning recommendations and 
techniques and build business process models that do not unnecessarily tax your system. Determine 
how much business data you will need to keep in your active system, and set up your processes to only 
save needed information. Follow the best practices for business process models. 

✦ Technical knowledge
Be familiar with the software applications, standards, security, and performance requirements that are 
related to your integration needs, or have personnel resources available who can help. As you 
configure the activities within your process models you will need a great deal of technical information. 
Business process models in Gentran Integration Suite are created in BPML code. A basic 
understanding of this format will help you work with business process models. 

✦ Periodic review
Periodically, review the construction of your business processes to confirm that they meet your reuse 
and performance requirements, and make adjustments as needed. 
After designing your initial processes, you may find that you can consolidate and trim the process to 
gain efficiencies. 

Business Process Model Planning Stages
The following table lists the phases of business process development, with a link to detailed instructions:

Stage You must identify: For details, see: 

1 Your business needs Identifying Business Needs on page 21

2 The separate activities that make up the process of 
fulfilling your business needs

Identifying Activities in a Business Process on 
page 21

3 Logical and manageable groups of activities within 
the process that can be developed as subprocesses

Identifying Subprocesses on page 22

4 Steps where the process can be automated Identifying Opportunities for Automation on page 
24

5 Integration points between steps Identifying Integration Points in Your Process on 
page 25

6 The most efficient structure for your business process 
model

Organizing Your Business Process Models on 
page 27
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Identifying Business Needs
In creating your architectural design plan, you may have completed some of these stages for all or some of 
the process models you will create. 

The topics describing each of the planning stages provide details, instructions, and an example process that 
continues from stage to stage. Proceed through the stages in sequence for the complete planning process.

Remember that the information provided here may not apply to every scenario; consider it a general baseline 
for all scenarios. 

Identifying Business Needs
Identifying your business needs consists of noting each business problem, goal, or scenario, and the related 
progression of actions required to resolve it. For example, if your business need is to process customer 
orders, you might note the following actions:

1. Receive order.
2. Route order to appropriate departments for processing.
3. Fulfill order.
4. Generate data for invoices.
5. Update inventory records.
6. Generate invoice statements.

The following illustration shows a sample depiction of the business need and its related actions :

When you have completed this stage, move on to Identifying Activities in a Business Process on page 21. 
This documentation uses the Customer Order Processing scenario throughout the remaining stages.

Identifying Activities in a Business Process
After you have outlined a business need and the steps that fulfill it, you must identify in detail the activities 
within each step that enable the process to move forward. 

7 Your needs for visibility into active and completed 
process activity

Maximizing Visibility Into Business Processes on 
page 30

Stage You must identify: For details, see: 

Need: Customer Order Processing

1
Order entry

5
Inventory 
control

3
Order 

fulfillment

4
Invoice data 
processing

2
Order 

processing

6
Accounts 

Receivable
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Identifying Subprocesses
For example, the following table identifies the activities in each step of the example process for Customer 
Order Processing (see Identifying Business Needs on page 21):

After you have outlined the activities within your process, proceed to Identifying Subprocesses on page 22.

Identifying Subprocesses
Remembering that the concept of reuse is the key to efficient ongoing management of your business process 
models, you must now take the time to identify possible subprocesses in your scenario (for information 
about the concepts of reuse and subprocesses, see Business Process Concepts on page 12).

Step Description Activities

1. 
Order 
Entry 

Customers order merchandise by sending 
EDI documents.

Orders enter system through a communications 
adapter for HTTP, AS2, or FTP, or through the EDI 
VAN.

2.
Order 
Processing

Translate and forward order data. EDI translator translates EDI document into order 
processing system format.

Order documents are sent to the order processing 
application.

Picktickets are produced and sent to warehouse.

Order processing application sends shipping 
information to order fulfillment department.

3. 
Order 
Fulfillment

Workers fulfill orders and initiate 
record-keeping.

Orders are picked.

Shipping records and pickticket information sent to 
data processing.

4.
Data 
processing

Data for filled orders recorded and 
transmitted.

Order data updated.

Invoice data generated.

Data sent to Accounts Receivable application.

Data sent to Inventory Control application.

5. 
Inventory 
control

Inventory data processed. Inventory control system records updated.

Process for augmenting inventory may be initiated.

6.
Accounts 
receivable

Invoice processed.  Accounts Receivable system generates invoice 
statements.

Invoices translated to EDI.

Invoices sent to customers through communications 
adapters.
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Identifying Subprocesses
Examine the outline of business process activity details you created in Stage 2, and look for logical, 
manageable groups of activities that you can create as separate subprocesses. Aim to create distinct process 
models for each subprocess within your overall scenario. You can then configure a parent process model 
that links the subprocesses. 

Also consider whether any predefined business process models provided with Gentran Integration Suite, or 
other business process models you are creating for your organization, perform activities that make up parts 
of your processes. If they do, you can use them as subprocesses. For information, see Using Predefined 
Business Process Models on page 32. 

A group of activities may be well-suited to configuration as a subprocess if any of the following are true:

✦ Together they accomplish a single unit of work. 
✦ The activities are generic enough to reuse. 
✦ The subprocess can be invoked in a generic way, which increases opportunities for reuse. 

For example, rather than building a situation-specific process model that uses a certain map according 
to hard-coded parameters in the process model, include the Typing or Lookup service to determine 
which map to use. 

✦ The activities are bracketed by a pair of related BPML activities (such as Sequence Start and Sequence 
End) or work within a specific business model. For example:

Request/Response

Produce/Consume

For information about BPML activities, see Organizing Your Business Process Models on page 27 and 
Gentran Integration Suite and BPML.

Subprocess Example
Step 2 in the example Customer Order Processing scenario (see Identifying Activities in a Business Process 
on page 21) consists of the following related tasks that together comprise a likely subprocess:

✦ Orders are translated into a format the order processing system uses.
✦ Order documents are sent to the order processing application.
✦ Picktickets are produced and sent to warehouse.
✦ Order processing application sends shipping information to order fulfillment department.
These activities comprise one unit of work, may be reused, and different adapters can call this process to 
initiate translation.

After you have determined which processes and subprocesses to create, proceed to Identifying 
Opportunities for Automation on page 24. You must complete the remaining stages for each process and 
subprocess you will create.
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Identifying Opportunities for Automation
Identifying Opportunities for Automation
Now that the business process, its steps, and the activities within those steps are defined, you must consider 
process automation. Process automation means running each step of a business process with little or no user 
intervention. Gentran Integration Suite provides a host of components designed to enable you to automate 
the bulk of your activities.

Highlighting Manual and Automatic Activities
Answer the following questions to determine which steps and activities in a process can be automated:

✦ Which steps of the process should run without user intervention or attention?
✦ At what step or steps in the process is human interaction necessary?
✦ At what step or steps is it necessary for Gentran Integration Suite to convert the document to the 

structure required by another system?
✦ What is the best method for starting the process?
✦ Do any of your applications need to process documents as soon as they are received?
✦ Should your applications send documents to a specified location or process when processing is 

complete? 

Example Process with Manual and Automatic Activities
The following table shows activities in the example Customer Order Processing model (see Identifying 
Business Needs on page 21) could be automatic and which could be manual: 
.

Step Activities

1. Order entry EDI orders enter system through the EDI VAN or communications adapter 
(Automatic).

2. Order processing Orders are translated into a format the order processing system uses (Automatic).

Order documents are sent to the order processing application (Automatic).

Picktickets are produced and sent to warehouse (Automatic).

3. Order fulfillment Orders are picked according to pickticket print-outs (Manual).

Workers scan each item picked into a hand-held scanner, routing data to inventory 
control and order system for updates (Manual and Automatic).

Shipping records and pickticket information sent to data processing (Automatic).

Exceptions process started if needed (for example, item not on shelf, backordered, 
etc.) (Automatic). 
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Identifying Integration Points in Your Process
When you have noted the automatic and manual activities within your process, proceed to Identifying 
Integration Points in Your Process on page 25.

Identifying Integration Points in Your Process
Integration points are points at which documents within your process move from one system or application 
to another.

Identifying these points helps you to pinpoint the technological requirements related to your process model, 
which you need to know before you can configure the appropriate components to execute the work. Be 
specific in naming the applications that must be integrated.

Communication Adapters for Integration
Adapters perform activities that control the transmission of business process data between Gentran 
Integration Suite and external applications. For example, in a customer order process, you can use adapters 
that enable Gentran Integration Suite to move documents from the order processing system to the accounts 
receivable system. The documents first go through a translation step so that they are in a format that the 
accounts receivable system can use. 

Carefully consider which external applications and systems you need to have communicate within your 
process model, then review the adapters Gentran Integration Suite has available to find the adapter that 
fulfills your need. If necessary, you can also create custom adapters using the Service Software Developer’s 
Kit (SDK).

4. Data processing Order data is updated (Manual).

Invoice data is generated (Automatic).

Data sent to Accounts Receivable application (Automatic).

Data sent to Inventory Control application (Automatic).

5. Inventory control Inventory control system records updated (Automatic).

Process for for augmenting inventory may be initiated (Automatic).

6. Accounts receivable Accounts Receivable system generates invoice statements (Automatic).

Invoices translated to EDI (Automatic).

Invoices sent to customers through communications adapters (Automatic).

Step Activities
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Example Integration Points Table
The following example table identifies the activities in which documents move from one system to another, 
within the example Customer Order Processing process (for information, see Identifying Business Needs on 
page 21), but this table does not name specific applications, as you should do for your actual plan: 

After you have completed Stage 5, you are ready to plan the best structure for your process models. Proceed 
to Organizing Your Business Process Models on page 27.

Step Activities Integration Points/Adapters

1. 
Order entry

EDI orders enter system through 
communication adapters or the EDI VAN.

Receipt through bootstrap adapter such as the 
File system adapter or an HTTP, AS2, or FTP 
adapter.

2. 
Order 
processing

Orders are translated into a format the 
order processing system uses.

Order documents are sent to the order 
processing application.

Picktickets are produced and sent to 
warehouse.

Translation from incoming EDI format into the 
format for:

The order processing system

Any backend system for storing order entry 
records to which the data may be routed

Any other systems used for tasks such as 
credit checks, approvals, etc.

Pickticket system

For example, translation may involve an incoming 
EDI 810 being transformed into an SAP IDOC.

3. 
Order 
fulfillment

Orders picked. 

Items scanned for data routing to inventory 
control and order system.

Shipping records sent to data processing.

Humans interact with pickticket data to fulfill 
orders. Use human interaction service to 
display pickticket data.

Resume automation when humans 
electronically send shipping records to data 
processing systems. This involves 
adapter/translation steps from scanner data 
entry format into the format for other systems.

4. 
Data 
processing

Order data updated.

Invoice data generated.

Data sent to Accounts Receivable 
application.

Data sent to Inventory Control application.

Use B2B adapters such as the AS2 adapter, 
SOAP adapter, or HTTP and FTP adapters, to 
send data to appropriate applications and 
initiate steps 5 and 6.

5. 
Inventory 
control

Inventory control system records updated.

Business process for for augmenting 
inventory may be initiated.

Bootstrap adapter, such as the HTTP Server 
adapter or FTP Server adapter, initiates 
inventory-related process.

6.
Accounts 
receivable

Invoices are processed.

Statements are produced.
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Organizing Your Business Process Models
Using the GPM to create your business process models is simple to do, but requires some knowledge about 
structuring the physical design of your process models in a way that makes them easy to understand and 
maintain. In addition, your process models must use specific BPML activities in circumscribed ways. 

BPML Activities Requirements
To construct viable business process models using the GPM, you must use certain BPML activities 
according to requirements related to their placement in your process models. Some activities must be used 
in pairs, to bracket other activities. That is, for a given activity, you must use one of these bracketing, or 
parent, activities at the beginning and one at the end. For example, before a series of activities in a business 
process model that you intend to run simultaneously, you must include the All Start BPML activity, and 
after the series, you must include the All End activity. For a complete list of available BPML activities 
depicted in the GPM, and the requirements related to using them, see BPML Activities in Business Process 
Models on page 35.

Organizational Concepts
The following table outlines concepts and structural elements related to designing business process models:

Concept or 
structural element

Description When to use

Subflow A subflow is a subset of activities in a 
business process model. In the GPM, a 
subflow is represented as an icon in the 
process model. You add the subflow icon to 
your process model and then define the 
components of the subflow. The subflow is 
invoked in sequence during process 
execution. Also see Layer on page 28.

Use subflows to streamline the display of your 
process model in the GPM by organizing a 
logical subset of activities in a single layer of 
the process model. This facilitates easy 
navigation among the separate parts, or layers, 
of your process model, while providing a 
simpler visual display of the process as a whole 
at the parent-layer level. 
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Subprocess See Subprocesses on page 13. Invoke 
subprocesses from within a business 
process model using either the Invoke 
Subprocess service (sometimes called 
Invoke Business Process service) or the 
Spawn BPML activity

See Identifying Subprocesses on page 22. For 
help determining whether to use Spawn or 
Invoke Subprocess to invoke a subprocess, 
refer to the following tips:

The Spawn activity asynchronously initiates 
another business process. 

The Invoke Subprocess service, as a 
Gentran Integration Suite service, is not 
portable to another BPML implementation, 
whereas Spawn – a standard BPML activity 
– is. 

Invoke Subprocess offers multiple 
configuration options, such as the ability to 
invoke the subprocess synchronously, run it 
inline, and so forth, that Spawn does not. 

Layer Layers are subflows contained within the 
business process model. The GPM enables 
you to chunk subsets of your business 
process model components into subflows, 
to streamline the depiction of the parent 
process’ flow in the GPM workspace. You 
can display the subflow activities in a 
separate workspace. 

Use the Layers tab in the GPM for easy 
navigation between the parent flow and any 
subflows.

Node Each activity depicted in a business process 
model in the GPM is a node. You can view 
an alphabetical list of the nodes in each 
layer of a process model.

Use the Nodes tab in the GPM for easy 
navigation when viewing and modifying the 
activities that make up the layers in your 
process models.

Decision point Activity in a business process model at 
which defined rules specify the processing 
activity or path to take. This activity is 
depicted by the Choice BPML icon. The 
Choice activity is a parent activity to child 
activities that it initiates.
For more information, see Decision Points 
and Rules in Business Process Models on 
page 33.

Include a decision point in a process model at a 
point where the continuation of the path must 
be determined according rules you define. The 
decision point can involve selecting one of two 
or more possible paths, or it may be part of a 
linear process that continues according to a 
rule.

Rule Rules are directions you define at a decision 
point in a process to determine the 
processing path. 

Use with Choice BPML activity for complex 
activities that require selection of one of 
multiple alternate activities. For more 
information, see Decision Points and Rules in 
Business Process Models on page 33 and 
Defining and Assigning Rules and Conditions 
on page 46.

Loop A flow, typically a subflow, within a business 
process model that repeats itself.

Use when you need an activity to repeat. The 
Repeat BPML icon initiates the loop.

Concept or 
structural element

Description When to use
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Using Adapters to Start Business Processes 
Some Gentran Integration Suite adapters can dynamically select and run business processes. These are 
known in Gentran Integration Suite as bootstrap adapters. These are generally input adapters, such as the 
File System adapter, Command Line Adapter 2, and FTP Client adapter. 

When you plan your business process models, use bootstrap adapters to run independently of the process 
model and then dynamically start the process whenever possible. This strategy encourages reusability, 
which is one of the best practices recommended for creating your business process models.

Using a bootstrap adapter involves configuring an instance of the adapter, in which you indicate the business 
process it starts. You can also configure a schedule for running the adapter. For example, in a 
translation-related process, you can use different configurations of the File System adapter, set up to poll 
different folders on systems for data input from different places, in different formats. Then, configure your 
business process model so that the different configurations of the adapter can call and start the same process 
to translate their data; the translator step determines on the fly which map to use to translate the format of 
the data it received.

Tying It Together
A good starting point for organizing a process model is the simple linear progression of activities that forms 
its basis. From there, add decision points, loops and subflows as needed, configure any activities that initiate 
subprocesses, and add OnFaults where appropriate. You might also find Xpath expressions and name-value 
pairs to be useful in the construction of your process models. For more information, see Assigning 
Name-Value Pairs in a Business Process Model on page 48. Always remember to follow the best practices 
for business process models.

When you have planned the structure of your process model, you must determine your document storage 
and tracking requirements and the appropriate settings you need to set for archiving and purging stored 
process data. For information, see Maximizing Visibility Into Business Processes on page 30.

Child activities Activities preceded in the business process 
model by a specific, structurally required 
BPML activity, such as Choice Start, 
Sequence Start or All Start. 

Review the BPML activities descriptions for 
information about how to structure parent-child 
relationships in business process models. See 
BPML Activities in Business Process Models on 
page 35.

Parent activities Activities in the process model that initiate 
child activities. For example, Sequence 
Start is a parent BPML activity to the 
services that follow it.

Review the BPML activities descriptions for 
information about the parent activities to use so 
that your models process correctly. See BPML 
Activities in Business Process Models on page 
35.

OnFault A BPML element you use to configure error 
handling in your process model. OnFault 
activities are associated with other 
individual activities.

Include OnFault activities when you need to 
enable a specific activity in a business process 
to recover from faults and allow the process to 
continue. An OnFault Group is a subflow.

Concept or 
structural element

Description When to use
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Maximizing Visibility Into Business Processes
Gentran Integration Suite provides a variety of monitoring and tracking tools that aid visibility into both 
your active and completed processes. 

As you plan your process models, considering the degree of access you need to detailed processing 
information is important, because you can configure related settings while you create your process models. 
Configure your processes and related resources to enable the visibility you need into processing details, 
along with the type of historical processing data you want to be able to access when you use monitoring and 
tracking tools. 

Monitoring and Tracking Considerations
You can configure your business processes to enhance your business process monitoring and document 
tracking options in different ways. The tracking options you configure determine the level and quantity of 
tracking detail specific to documents, as opposed to business processes themselves, that is available in 
Gentran Integration Suite. Tracking selections may affect system performance. Consider the following:

✦ Using the document tracking flag at check-in – When you check in a business process, you have the 
option to enable or disable document tracking. 
When you have enabled document tracking for a business process, the system carries tracking 
information with the document throughout the process, and persists the tracking information about the 
document regardless of the persistence level you configured globally for Gentran Integration Suite. 
Document tracking in a business process allows you to use monitoring features to track processing 
history, view transaction details, obtain processing state information, and so forth, for documents.
By default, the document tracking option is disabled for all business processes in Gentran Integration 
Suite. Therefore, even if the global system tracking option is configured to enable tracking, your 
business processes will not will not provide the specialized document tracking unless you enable 
document tracking at check-in. 
Using document tracking may affect system performance. Determine your document tracking and 
performance needs before creating your business process models.

✦ Setting Tracking Level for EDI services – For EDI-related business processes, you can boost 
performance without having to modify multiple business process models by changing the tracking 
level setting in envelope properties to either None or Basic, depending on the level of functionality you 
need. The only reason to adjust EDI tracking is for performance reasons. There is a trade-off in that 
you need must ensure that you still track all the data you need if you lower this level
If, instead, you use the tracking level service parameter to set this value, the tracking level service 
parameter setting overrides the enveloping properties setting. 

✦ Using the Correlation service or name-value pairs for correlation searches – You can configure 
services to collect information for a specific name and value pair from either documents that pass 
through the business process, or from the business process itself. For information, see Assigning 
Name-Value Pairs in a Business Process Model on page 48.

✦ Invoking subprocesses to run inline – For tracking purposes, a subprocess initiates as a new business 
process with its own instance ID. However, you can opt to run a subprocess in inline mode by selecting 
inline as the invoke mode in the parameters for the Invoke Business Process service that calls the 
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subprocess. This way, the subprocess steps are reported in tracking as part of the parent process. 
Recommended practice is to always use inline invoke unless you have a business need to run a 
separate process. 

Persistence Levels and Archive and Purge Settings
When your business processes run, Gentran Integration Suite saves data according to the level of persistence 
you have set (see Persistence Level on page 59). You can access more or less saved information about the 
processes you run, depending on the degree of persistence you set (remember that enabling document 
tracking overrides persistence settings related to documents). The length of time that the persisted data is 
available to you depends on the lifespan of the defined process. 

In the same manner that you schedule initiation of business processes, you can schedule the intervals at 
which you want Gentran Integration Suite to archive and purge the contents of the database. Configuring 
archiving and purging enables you to define the length of time, in days and hours, to retain the data persisted 
in Gentran Integration Suite. Performance considerations may influence your options, as a great deal of data 
in the database can slow operations. For more information, see Life Span on page 64.

Document Storage Considerations
Document storage settings determine the storage location you want for documents that process when the 
business process runs. The levels are:

✦ Database – Store documents in the database. Use this option for small documents or when clustering 
without a clustered file system.

✦ File System – Store documents in the file system. Use this option for large volume processing, such as 
documents that are over 10 MB in size, or when working with a large number of documents within a 
single business process (including any sub-processes it invokes). 

Note: If you are using archiving, and you using the file system document storage method, you must handle 
purging the documents from your file system manually.

✦ System Default – Use the default option configured in the jdbc.properties file. As shipped, the database 
is the system default. You may have modified this to use the file system.

✦ Inherited – Store documents according to the document storage setting applied to the service that is 
invoking this business process. Use this option when the process is invoked by a bootstrap adapter and 
you want the document storage method to carry from the invoking adapter to the process.

✦ This option enables you to configure the process model to use the same document storage method as 
the bootstrap adapter that will invoke the process.

For additional information about the processing options you can select when you check in a business 
process, see Business Process Model Processing Options on page 57.

When you have completed Stage 7, you may benefit by filling out the Planning Worksheet for your business 
process model. The worksheet is a form you can use to note conceptual and technical details about a process 
model and refer to it during the actual modeling of your process.
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Using Predefined Business Process Models
Gentran Integration Suite provides a variety of predefined business process models for your convenience. 
In addition, any business process model you have previously created and checked in essentially becomes a 
predefined business process. You can use a predefined process in the following ways:

1. Use it as a subflow in a new process model. 
To do this, you must:

Check out the predefined process and save it with a new name. This should be the name of the 
process model you are creating that will include the predefined process.

In the GPM, open the file you checked out and saved.

Create a subflow in the process model and add the predefined process to it.

Model the rest of your business process related to the subflow.

Test the model and check it in to Gentran Integration Suite.

Remember that after you use a process as a subflow in a new process, any changes you may make later 
to the originally copied process will not be reflected within the subflow. For instructions for adding a 
subflow within a process model, see Adding Subflows in the GPM on page 45. 

2. Configure a step in your process model to execute a predefined process as a subprocess.
To do this, use the Invoke Subprocess service. 
The benefit of using this technique is that if you later make changes to the predefined process, the 
process model that calls the predefined process as a subprocess uses the most current version.
For tracking purposes, a subprocess initiates as a new business process with its own instance ID. 
However, you can opt to run a subprocess in inline mode. Using this option, the subprocess steps are 
reported in tracking as part of the parent process. Running the process inline enables you to maintain 
reusability and inherited updating without the possibility of negatively affecting system performance 
by starting a new business process. You set the inline options in the parameters for the Invoke Business 
Process service.

3. Use it as a foundation for a new process.
To do this, you must:

Check out the predefined process and save it with a new name. This should be the name of the 
process model you are creating.

In the GPM, open the file you checked out and saved.

Modify the configuration of the business process model as needed.

Test the model and check it in to Gentran Integration Suite.
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Locating and Identifying Predefined Business Process Models
To review predefined business process models and determine whether they will fulfill your needs, you must 
open the files for the models and review their components. To do this, check out the business process and 
open it in the GPM, or view the source BPML in the interface. You can open a read-only copy.

To view the source BPML in the interface:

1. From the Business Process menu, select Manager.
2. Under List select ALL and click Go! 
3. Click the name of the business process for which you want to view the source , and review the source 

BPML in the window that displays.

For descriptions of several commonly used predefined business processes, see Commonly Used Predefined 
Process Models on page 83. 

Note: The reference information for each service and adapter identifies any predefined business processes 
associated with it. You can use this information as a starting point for finding a useful predefined 
process.

Decision Points and Rules in Business Process Models
To configure decision points in your business process models, you must:

✦ Define a rule upon which conditions will be based.
✦ Add the decision point in your process model.
✦ Assign the rule and related conditions to the decision point.
For example, for a decision point at which the flow of a business process model splits into two paths 
determined by the total amount of a purchase order, you define a rule indicating the total amount of the 
purchase order, such as: PO is greater than $10,000.

Then, you must assign the rule to the decision point within your process model, and indicate the conditions 
by which the data progresses through each path from the decision point. For our example, if the total PO 
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amount is greater than $10,000 (true to the rule), take path A; and if the total PO amount is not greater than 
$10,000 (not true to the rule), take path B. The following diagram illustrates the concept:

Rules and Conditions for XML Documents
When running a business process that processes XML documents, you must use XPath to describe rules and 
conditions for processing the XML document. Specifically, you must create XPath expressions that:

✦ Identify particular elements (or nodes) and their positions in both the input and output documents.
✦ Identify particular elements in the input document for copying into an output document or for further 

processing.
✦ Define any constraints of name-value pairs for elements.
✦ Calculate values that depend on other values.
The following table shows sample names and rules using simple syntax: 

For information about assigning rules that require complex syntax, see Defining and Assigning Rules and 
Conditions on page 46.

Name Rule

rule1 X>10

rule2 X<=10

rule3 X<10

PO in

Choice

(Rule = PO amount 
is > $10,000)

Path
 A

The rule 
is true

Path B
The rule is 

not true Activity

Process
Continues

Activity

Business process

Initial 
process 

steps

Decision point Paths determined by conditions
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BPML Activities in Business Process Models
Some BPML activities must be used in pairs, to bracket other activities. That is, for a given processing step 
in a business process model, you must use one of these bracketing activities at the beginning and one at the 
end. These are considered to be parent activities. For example, before each service in a business process 
model, you must include the Sequence Start BPML activity, and after the service you must include the 
Sequence End activity. Other BPML activities enable more complex activities.

✦ Parent Activities Used in Pairs on page 35
✦ More Complex BPML Activities on page 36
This topic explains requirements related to your use of BPML activities in business process models. Your 
processes may not run correctly if you do not use the BPML activities according to the requirements 
outlined here.

Parent Activities Used in Pairs
The following table describes the BPML icons in the GPM that represent activities used to bracket other 
activities: 
 

Icon Description

The Start activity indicates the beginning of a business process. Every business process 
model must begin with Start. 

The End activity indicates the end of a business process. Every business process model 
must finish with End.

The All Start activity is a parent activity in a business process. All Start indicates that a 
business process is simultaneously executing all of the child activities contained within the 
parent activity. 
The All activity runs two or more complex child activities within a business process 
simultaneously. Because there are performance implications to using the All activity, use it 
only if you expect branches of your business process model to take significant amounts of 
time (in seconds or minutes) to complete (very few services take this long). 
Do not use the All activity to run two or more instances of the same subprocess 
simultaneously. The system will handle the proper load balancing.

The All End activity indicates that all child activities within the parent activity are completed. 
Use All End to finish All Start.
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More Complex BPML Activities
The following BPML activities are not used in pairs to bracket business process model components. Rather, 
they enable more complex operations within a business process. The following table describes the icons and 
activities: 
 

The Choice Start activity is a parent activity in a business process. Choice Start indicates a 
decision and runs one child activity as a result of that decision. You must assign a name to 
Choice Start using the Property editor and assign rules using the Rule Manager. 

The Choice End activity indicates that the child activity that ran as a result of the parent 
activity is completed. Use Choice End to finish Choice Start.

The Sequence Start activity is a parent activity in a business process. Sequence Start runs a 
series of child activities in the order in which they are listed within the parent activity. When 
using Sequence Start, you must assign a name using the Property editor.

The Sequence End activity indicates that the last child activity in a series of child activities in 
the parent activity is finished. Use Sequence End to finish Sequence Start.

Icon Description

The Assign activity sets a value in the business process data that is equal to a fixed value. Inside an 
input or output element, the activity identifies a message it should receive from a participant or 
identifies the contents of a message it should send to a participant.
Configuration parameters enable you to indicate a fixed value or input/output message.

The Consume activity reads a specific input message and stores that message in the business 
process data. 
Configuration parameters enable you to indicate a name for an instance of the Consume activity 
and the name of the message this activity should read.

The Join activity merges the results of a completed nested business process into the business 
process data. 
Configuration parameters enable you to indicate a name for the business process for which the Join 
activity is waiting.

The OnFault Group activity is a subflow used to associate a fault handling activity with a complex 
activity. Use it to recover from faults and allow the process to continue.

Icon Description
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The Produce activity generates a message from the business process data and delivers it to a 
designated participant or activity. 
Configuration parameters enable you to indicate the message and name of the receiving participant 
or activity.

The Repeat activity runs an activity or subflow one or more additional times. 
Configuration parameters enable you to indicate a name for an instance of the Repeat activity and 
the name of the activity the Repeat activity should run again. 

The Spawn activity runs a subprocess. 
Configuration parameters enable you to specify a name for a copy of the Spawn activity within a 
process model, as well as the name of the subprocess to invoke.

Icon Description
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About Creating Business Process Models
Gentran Integration Suite enables you to use different applications to create your business process models, 
as indicated in the following table:

Application Description

Graphical Process 
Modeler (GPM)

Web-deployed application included with Gentran Integration Suite. The GPM interacts 
directly with Gentran Integration Suite although it is an independent application. The 
GPM offers ease-of-use, including:

Process model validation and check-in integrated with Gentran Integration Suite

Visually represented and manipulatable modeling components including Gentran 
Integration Suite services and adapters

Configuration tools that do not require advanced BPML knowledge

Unless you have advanced knowledge of BPML, XPath, and ebXML syntax, use the 
GPM to create your business process models.
For instructions for creating a business process model using the GPM, see Creating or 
Modifying a Business Process Model in the GPM . For information on BPML activities 
used in the GPM, see BPML Activities in Business Process Models. 

Text editor application If you are experienced with using a text editor to create business process models in 
BPML code, you can use a text editor application. Gentran Integration Suite interface 
provides a built-in text editor in which you can enter the BPML code and validate and 
check in your process models. If you have written the BPML code in a text application 
external to Gentran Integration Suite, you can copy the text from the external application 
and paste it into Gentran Integration Suite text editor.
For instructions to create a process model using a text editor, see Creating and Modifying 
Business Process Models In the Text Editor . 
Unless you have advanced knowledge of BPML, XPath, and ebXML syntax, use the 
GPM to create your business process models.

Non-Gentran Integration 
Suite graphical editor 
application

Process models created in other graphical editors may be imported into Gentran 
Integration Suite, provided they are exported in a standard XML format. The imported 
business process model, and some services, may require modification for correct 
execution in Gentran Integration Suite. 
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Process Summary of Creating a Business Process Model in 
the GPM
The following table lists the stages in the process of creating a business process model using the GPM. The 
table provides links to additional information.

This process assumes that you have completed the planning steps described in Business Process Model 
Planning Stages on page 20 and reviewed Business Process Modeling Best Practices.

Stage Description For details, see:

1. Create the business process, including the appropriate service 
configurations. 

If an existing service configuration meets your business needs for 
the process, use that service configuration.

If no existing service configuration meets your business needs, 
create a new service configuration or determine whether you can 
edit an existing configuration to make it more generic for reuse.

Note: To avoid negatively affecting your other business 
processes, do not edit an existing service configuration 
until you understand its impact on your other business 
processes.

Creating or Modifying a 
Business Process Model in the 
GPM on page 40. 

2. Configure the process to call subprocesses, if needed. Using Predefined Business 
Process Models on page 32

Identifying Subprocesses on 
page 22

3. Add subflows, if needed. Adding Subflows in the GPM on 
page 45

4. Configure any required and optional parameters for services and 
adapters in your process, such as metadata and message data.

Configuring Parameters in GPM 
Element Editors on page 43

5. Assign rules and conditions to decision points, if needed. Defining and Assigning Rules 
and Conditions on page 46

6. Configure services to enhance monitoring and tracking capabilities, if 
needed.

Assigning Name-Value Pairs in 
a Business Process Model on 
page 48
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Creating or Modifying a Business Process Model in the GPM
You can create an original business process model from scratch, or by modifying an existing process model 
and saving it with a unique name. If you are using an existing process model as the foundation for your new 
process, see the following topics for more information: Using Predefined Business Process Models on page 
32 and Copying a Business Process Model for Use In the GPM on page 50.

Before using the GPM, review the GPM documentation.

Preliminary Configuration Tasks
You must perform the following configuration tasks before creating a process model:

✦ Create any necessary service configurations in Gentran Integration Suite. For information about 
service configurations and business processes, see Service Configurations in Business Process Models 
on page 15.

✦ Validate and check in any business process model you intend to invoke (use as a subprocess) from this 
process. Subprocesses must be checked in to Gentran Integration Suite in order to test this process.

Procedure
To create a business process model using the GPM:

1. Open the GPM. 

7. Validate and save the business process model.
For information, see Business Process Model Validation on page 54.

In Gentran Integration Suite 
interface, this step is included in two 
larger processes:

Creating a process model in the 
text editor – for information, see 
Creating and Modifying 
Business Process Models In the 
Text Editor on page 50.

Checking in a business process 
model created in the GPM. For 
information, see Checking In a 
Single Business Process Model 
in the GPM on page 65.

In the GPM, you can validate a 
process model during the creation 
process or at any later time. 

Stage Description For details, see:
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2. In the GPM, from the File menu, select New to open a new document, or open the .bp file you want to 
use as a foundation for a new process model (checked out business process models are saved as .bp 
files). 
Note: If you open a business process model that was created or edited in the text editor, the GPM 
displays the components in “autolayout” mode—the icons are aligned in a linear arrangement. 

3. Open the stencils containing the service icons you need to create the business process model. For each 
stencil you need, from the View menu, select Stencil > <stencil name>.

4. Click the title bar for the BPML stencil to expand the stencil (the BPML stencil is open by default).
5. If you are creating this process model from scratch, add the Start icon to the business process 

workspace by dragging and dropping that Start icon onto the workspace.
To add an icon to a business process model, click to select the appropriate icon from within a stencil, 
and then, holding down the mouse button, drag the icon onto the workspace and release the mouse 
button.

6. Add other icons to the business process model as needed:

From the BPML stencil, add icons representing BPML activities and instructions required in your 
business process.

From the stencils, add icons representing services, BPML activities and instructions, and 
integration points in your business process. 
This step might include adding one or more subflows, as well as services to invoke other process 
models (subprocesses).
For more information, see the following topics:
- If you want to use a service that is not installed, contact your system administrator. 
- Adding Subflows in the GPM on page 45.
- For how to invoke another process model from within this one, see Using Predefined Business 
Process Models on page 32.

7. If you are using a predefined business process model as the basis for creating this process model, 
remove any icons that you do not need to keep for the new model.

8. If you are creating this process model from scratch, add the End activity to the business process model.
9. Arrange the icons in the order that meets the requirements of your business process. Do not use the 

Autolayout tool unless you have arranged and linked your icons first (complete step 10), because it 
will line up the icons in a vertical row that takes time to reorganize appropriately.

10. To link the icons, click the arrow on the right side of the first icon and drag it to the arrow on the left 
side of the next icon. Repeat as necessary.

11. Customize descriptive annotations to your model, if desired. For instructions, see Modifying 
Annotations on page 48.

12. Assign any name-value pairs that represent data to locate in process data, as needed. For instructions, 
see Assigning Name-Value Pairs in a Business Process Model on page 48. 

13. Assign rules and conditions to decision points, if needed. For instructions, see Defining and Assigning 
Rules and Conditions on page 46.
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14. Configure parameters as needed for services, adapters and BPML activities. For instructions, see 
Configuring Parameters in GPM Element Editors on page 43.

15. From the File menu, select Save to save the business process model document (.bp file) to your client 
computer. If you have configured the GPM to validate automatically when you save a file, the system 
validates your process model now.
If this is a new process created from scratch, give the business process model a unique and meaningful 
name so that you can identify it easily.

16. In the Save dialog box, select a directory on your client computer and click Save.
After creating a business process model, at any time, you can open the file for your business process 
model and configure parameters, add subflows as necessary, assign rules and conditions, validate it, or 
otherwise modify it.
In order to test or run the process in Gentran Integration Suite, you must:

Validate the process model’s format. For information, see Business Process Model Validation on 
page 54.

Check the model in to Gentran Integration Suite (your test or production environment, 
accordingly). For instructions, see Implementing a Business Process Model on page 53.

Create and check in any other resources (such as Web templates, service configurations, maps, and 
so forth) that will be used by this model.

You can now check in and test your business process model. If needed, create a schedule for running this 
business process model.

When to Configure Services for Business Process Models
The services you include in your business process model may require configuration in order for your process 
to run correctly. You configure some parameters in Gentran Integration Suite interface (this is called 
creating a service configuration), some in either the interface or the GPM, and some exclusively in the GPM. 
A few require manual editing in the BPML code. The reference documentation for each service describes 
the parameters for the service and indicates where to perform the parameter configuration.

Generally, you can configure service parameters either during initial service configuration in Gentran 
Integration Suite interface, or during business process creation using the GPM. You can modify service 
configuration parameters at any time. 

About Refreshing the Service Configurations in the GPM 
If you are working in the GPM and you use Gentran Integration Suite interface to change the configuration 
for a service, you must select View > Refresh Services to update the GPM with your modified service 
configuration.
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Configuring Parameters in GPM Element Editors
Configure service parameters in the GPM when you need to customize the service for the business process 
you are creating or modifying. To configure parameters:

1. In the workspace, double click the icon representing the service, adapter, or activity you want to 
configure. 
The GPM displays the appropriate element editor for the selected element in the Element Editor pane 
beneath the workspace. For example, when you select the Assign icon, the Property editor opens, 
providing parameters to configure. For most services, the Service editor displays.

2. Configure the parameters by entering the appropriate values in the related fields as needed. 
For Service Editor only: The following table describes parameters in the Service editor. Some 
services and adapters have additional parameters that display in addition to the parameters described 
here, which are documented with the service information.

Field Description

Name Name of the service you are using in your business process model. 
You can customize the name, but, to facilitate your future reference, the best practice is to leave 
the name as-is or to include the service name in the new name you create. This is especially 
helpful should you need to identify business processes that may contain retired services at a later 
date.

Config Name of the service configuration for this service that you want to use in this business process 
model. The field displays previously created service configurations for the selected service.
After you select a service configuration, additional configuration parameters display.

Output Msg Choose one of the following types of information:

Message Only – Send only service configuration information to a service.

Obtain Message first, then Process Data – Send service configuration information, name-value 
pair in the Service editor, and business process data. If duplicate information exists between 
the service configuration and business process data, the business process data overrides the 
service configuration information.

Obtain Process Data first, then Message – Send service configuration information, name-value 
pair in the Service editor, and business process data. If duplicate information exists between 
the service configuration and business process data, the service configuration information 
overrides the business process data.

Note: When sending name-value pairs, you must indicate in the Service editor the name and 
value that describes the path for sending the name-value pairs. 

For more information about name-value pairs, see Assigning Name-Value Pairs in a Business 
Process Model on page 48. For information on Output Msg, see What is Process Data?.

Input Msg When a service sets variables in business process data (select one):

Allow message write – Do not save the variables.

Allow Process Data write – Save the variables.

For more information about Input Msg, see What is Process Data?.
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3. Do you need to configure any XPath expressions for the service?

If Yes, see Adding XPath Expressions to Service Configurations in the GPM on page 44.

If No, proceed to the next step.

4. Do any?
5. Are you trying to configure a parameter that is read-only?

If Yes, complete the procedure in Modifying Read-Only Parameters in the GPM on page 44.

If No, proceed to the next step.

6. When you are finished, you can close the Editor tab in the Element Editors pane by right-clicking the 
Editor tab and selecting Close Editor Tab. However, you do not need to close the pane. Any time you 
double-click a step in the process model, the display automatically changes to the appropriate editor 
for the selected icon. Likewise, if you validate the process model, the pane changes to display the 
system output messages.

Modifying Read-Only Parameters in the GPM
At times, you may need to modify service parameters but find that they display as read-only in the GPM 
Service editor. Some service parameters that are configurable in both Gentran Integration Suite interface 
and the GPM display as read-only in the Service editor if you configured them in the interface prior to 
working with them in the GPM. 

The GPM enables you to override these preconfigured settings so that you can modify the parameters. To 
enable the parameters to be changed in the GPM:

1. From the Options menu, select Preferences. 
2. Select the Service Editor tab.
3. Select Override Default Service Configuration Values and click OK. 

If the Service editor is already open when you complete these steps, you must exit the Service editor 
(right-click the Editor tab and select Close Editor Tab) and then re-display the Service editor for the 
change to take effect (double-click the service icon in the workspace).

Adding XPath Expressions to Service Configurations in the GPM
To add an XPath expression to a service configuration, 

1. Select the service in the Workspace and in the Service editor, click Advanced.
2. Click Add to display the Name and Value columns.
3. In the Name field, type a unique name for the rule you are creating.
4. Click in the field under the Value column and select the ... button.
5. In the Value of Null dialog box, click the A + B button to display the XPath Expression Builder.

After closing the Service editor, point to the value column in the Advanced editor so that the 
expression button disappears. This action sets values.

6. Create your expression, following the instructions for using the XPath Expression Builder. 
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7. Click OK. See also Assigning Name-Value Pairs in a Business Process Model on page 48.

Adding Subflows in the GPM 
When you create a subflow, you create a layer in the business process model. You can expand the view to 
work with the components of the subflow by using the Layers tab in the Navigation pane. 

While a subflow layer provides more design space, it does not create a separately-saved business process 
model. A subflow is an integral part of the process for tracking purposes.

For information about planning subflows for your business process models, see Organizing Your Business 
Process Models on page 27.

To add a subflow:

1. From the Tools menu, select Add Sub Flow. The GPM adds the subflow icon to the workspace and 
expands the structure in the Navigation pane to show the subflow. 

2. In the workspace, drag and drop the subflow icon to the appropriate location within the business 
process model. 
You may need to remove the link that connects two previously arranged icons in order to insert the 
subflow icon. To remove the link, click the link and press Delete.

3. Link the icons accordingly.
4. To rename the subflow, select the subflow icon, right-click, and select Properties to display the 

Property editor. Type the name for the subflow in the Value field. When you click out of the Property 
editor, the subflow icon displays the new name in the workspace. Now you are ready to configure the 
subflow components.

5. In the Layers tab of the Navigation pane, click the subflow to display the workspace for the subflow. 
The GPM includes unlinked Start and End icons for your convenience. 

6. Create a business process model for the subflow:
a. Add the icons that meet the requirements of your business process.
b. Arrange the icons.
c. Link each icon, including the Start and End icons.
d. Align the business process model.
e. Configure parameters for the icons in the subflow using the element editors as needed.

7. Do you want to continue working on the parent business process model (the one that the subflow is 
part of)?

If yes, in the Navigation pane, click the parent business process model icon to display to the parent 
process in the workspace.

If no, save the business process model or validate and save the business process model.
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Defining and Assigning Rules and Conditions 
To include rules and conditions at decision points in your business process models, you must complete two 
procedures:

1. Define rules. These may be simple or complex. For instructions, see:

Defining Simple Syntax Rules on page 46

Defining Complex Syntax Rules Using XPath on page 46

2. Assign the rules and related conditions in a business process model. After defining your rules, or if 
your rules are already created, see Assigning Rules and Conditions in Business Process Models on 
page 47.

These procedures assume you have planned your business process model and created its core structure in 
the workspace in the GPM. For a conceptual overview, see Decision Points and Rules in Business Process 
Models on page 33. 

Defining Simple Syntax Rules
1. From the Tools menu, select Rule Manager.
2. Click Add.
3. In the Name field, type a name that describes the rule. 

For example, if you are creating choice within your process model that determines what step to take if 
the total amount in a purchase order is greater than or less than $10,000, you might define a rule named 
TotalPO.

4. In the Expression field, type the syntax, and then click OK.
Following the example in step 3, the expression might be document/total> 10000. 

5. Repeat these tasks until you finish defining simple syntax rules.

You can now assign rules you have created to steps in a business process model. See Assigning Rules and 
Conditions in Business Process Models on page 47.

Defining Complex Syntax Rules Using XPath
1. From the Tools menu, select Rule Manager.
2. Click Add.
3. In the Name field, type a name that describes the rule.

For example
4. To display the XPath Expression Builder, click the (A + B) button to the right of the Expression field.
5. Display the expression type you want to perform, double-click the function to add it to the Expression 

field, and then type values to complete the expression type as needed.
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6. Display the token set attribute to complete the function of the expression type and double-click the 
attribute to add it to the Expression field. 

7. Repeat steps 1-6 until you finish defining this XPath expression and click OK.
8. Repeat steps 3-7 until you finish creating rules defined by complex XPath.

You can now assign rules you have created to steps in a business process model. See Assigning Rules and 
Conditions in Business Process Models on page 47.

Assigning Rules and Conditions in Business Process Models
In the process of creating the core structure of your business process model in the workspace, you may have 
already completed steps 1 and 2.

To assign rules:

1. To a business process model open in the workspace, add the decision point to which you will assign 
rules, along with related icons for each possible processing sequence (you may need to remove the link 
that connects two icons in order to insert the new icons):
a. At the appropriate point in the process model, add the following icons:

Choice Start and Choice End

Two copies of Sequence Start and Sequence End

Icons for the activities required in each sequence. For example, two copies of the Assign icon.

b. Arrange and link the icons. For example:

2. Configure the parameters for the service in each sequence as necessary (for example, the Assign 
activity icons). For instructions, see Configuring Parameters in GPM Element Editors on page 43.

3. Rename the following icons as indicated:

Rename Choice Start to describe the decision activity. For example, CheckTotalPO.

Rename the Sequence Start icons to describe the condition related to each flow path. For 
example, one might be Total10000 and the other might be TotalNot10000.

4. Double-click the edge (link line) between Choice Start and one of the Sequence icons to display the 
Edge editor.

5. In the Edge editor, click Add to display the name and value columns.
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6. In the Name column, click in the field to display a list of previously-created rules, and select the 
appropriate rule. This will be the rule name displayed with the selected edge in the business process 
model.

7. In the Value column, select True or Not true for the selected rule. 
When you click in the workspace, the rule name displays on the edge in the process model.

8. Do you need to assign more rules to this edge? 

If Yes, repeat steps 5 - 7 until you finish assigning rules to this edge. 

If No, repeat steps 4 - 7 for other edges to which you must assign rules.

Modifying Annotations
You can customize annotative descriptions of components in your process model. Though you cannot delete 
the default annotation for an icon, you can modify it to provide descriptive information that is useful to you.

To customize an annotation:

1. In the workspace, select the icon for which you want to customize the annotation.
2. From the Edit menu, select Annotation.
3. In the Annotation dialog box, type the annotation, and click OK. 

Deleting an Annotation 
You can delete a custom annotation by clearing it, but the GPM automatically replaces it with the default 
system annotation for the icon. To delete an annotation:

1. In the workspace, select the icon for which you want to delete a custom annotation.
2. Right-click to display the menu and select Annotation.
3. Click Clear, and then click OK.

Assigning Name-Value Pairs in a Business Process Model
Assigning name-value pairs to business processes and documents enables you to easily search for and 
monitor the business process and related documents. Name-value pairs, which are called correlations in 
Gentran Integration Suite, enable a business process to identify corresponding elements (or nodes) and their 
positions in both the input and output documents.

You can use any of the following methods to assign name-value pairs:

✦ Applying the provided name-value pairs provided in the GPM to a service
✦ Creating your own unique name-value pairs for a service
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✦ Implementing the Correlation service to enable Gentran Integration Suite to generate correlations, 
according to a business process, or according to documents exchanged as a result of a business process 
that ran.

Assigning Provided Name-Value Pairs in the GPM
To assign name-value pairs to a service:

1. To display the Service editor, select the icon representing a service or adapter and click Properties.
2. Under the Value column, select the value that describes the name-value pair corresponding with 

elements in both the input and output documents.

Creating Unique Name-Value Pairs
To create unique name-value pairs for a service:

1. To display the Service editor, select the icon representing the service or adapter and click Properties.
2. Click Advanced to display the Advanced Editor.
3. Click Add to display the Name and Value columns.
4. Under the Name column, type a unique name to describe the value in the field.
5. Under the Value column, type a character or XPath expression that describes the value in the field. 

Note: To use the XPath Expression Builder to help you create an XPath expression, click the ellipses 
button to display the Value of Null dialog box, and then click the button to the right of the Value field 
to display the XPath Expression Builder. See Adding XPath Expressions to Service Configurations in 
the GPM on page 44.

6. Under the Use XPath? column, enable the field to indicate that you are using an XPath expression for 
the value, and then click Add.

7. Repeat steps 1 - 6 until you finish creating name-value pairs for this service or adapter.

Using the Correlation Service
When you use the Correlation service in a business process, Gentran Integration Suite generates correlations 
for business processes that completed document exchange while running. After running the business 
process, you can then use the generated correlations when you search for a business process or document 
results in Gentran Integration Suite. 

Before using the Correlation service, you must determine whether you want Gentran Integration Suite to 
generate correlations according to the results of business processes or document exchange.
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Copying a Business Process Model for Use In the GPM
At times, you may want to copy a business process model and use it as the foundation for a new one. To 
copy a business process model:

1. Check out the business process you want to copy and save it with the name of the new process model 
you are creating.

2. In the GPM, open the business process model you checked out.
3. Modify the business process model as needed.
4. Validate and check in the new process model.
5. If you locked the original business process model at checkout, and you need it to be available in 

Gentran Integration Suite, check it back in.

Creating and Modifying Business Process Models In the Text 
Editor 
Creating a business process model using a text editor rather than the GPM requires advanced knowledge of 
BPML, and XPath. Unless you are an advanced user, use the GPM to create your process models. 

The process for creating a business process using a text editor in Gentran Integration Suite includes 
validation and check-in of the process model. The following procedure details the steps:

1. From the Business Process menu, select Manager.
2. Do one of the following:

To create a new process model, next to Create Process Description, click Go!

To modify an existing process model, use the Search or List feature to locate the model to modify, 
select Source Manager for the process, and click Edit. Go to step 5.

3. Type the name to identify the business process you are creating. The name must not contain spaces. 
See Process Name on page 57.

4. Under Select an input mode for defining the new process, select Business Process Text Editor and 
click Next.

5. Type a description that helps identify the business process you are creating or modifying. See 
Description on page 57.

6. In the Business Process field, either type, or copy and paste, BPML code.
7. Click Validate to validate the BPML syntax (you cannot enable a business process until it is 

validated). 
A system message indicates whether the process is valid or invalid.

8. Is the process valid?
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If No, correct invalid BPML code and repeat step 7 as necessary. You can view error information 
by clicking the link in the error message.

If Yes, click Next.

9. Select Document Tracking if you want to track the progress of the document when the business 
process runs. See Document Tracking on page 58.

10. Select Set onfault processing if you want the business process to run its onFault protection if it 
encounters an error when it is running. See Set onfault processing on page 58.

11. In the Set Queue field, indicate the level of queue, previously defined to allocate resources, at which to 
place this business process for processing. See Set Queue on page 58.

12. Indicate the level of persistence to retain data that makes up the business process. See Persistence 
Level on page 59.

13. Indicate the level of event reporting for this business process. See Event Reporting Level on page 60.
14. Indicate the level of recovery for this business process if the business process should halt during 

execution. See Recovery Level on page 60.
15. Indicate the type of document storage for documents that process when the business process runs. See 

Document Storage on page 60.
16. Click Next and select deadline settings for the business process to run. See Gentran Integration Suite 

Deadline Settings on page 63.
17. Click Next and indicate the life span (archiving information) for the level of persistence data you are 

retaining. See Life Span on page 64.
18. Click Next.
19. To enable the business process, ensure that Enable Business Process is selected. 

If you do not enable the business process, you cannot run it in Gentran Integration Suite without first 
enabling it later. For instructions to enable it independently of the check-in procedure, see Enable a 
Disabled Business Process on page 81.

20. If you want to create a permission associated with the business process model, select Create 
Permission, and then click Finish. 

You can now test the business process model. If needed, create a schedule for running this business process 
model.

Note: If you edit a file in BPML and then open the file in the GPM, the model displays in Autolayout mode; 
it does not keep its original GPM layout, if applicable, after its source file has been manually edited.

Creating a Subprocess 
The following steps describe the process of creating a subprocess:

1. Follow the instructions for creating a business process model, remembering that a subprocess should 
comprise a simple, single unit of work.

2. Validate the subprocess.
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3. Check the process model in to Gentran Integration Suite.
4. Test the subprocess, monitoring the activity. If needed, modify the process model and repeat steps 1-4 

as needed.
5. Create a business process model that calls the subprocess (this is the parent business process model). 

The Invoke Business Process service enables you to call the subprocess from the parent process and 
specify the processing mode (asynchronous, synchronous, or inline).

6. Validate and check in the parent business process model. 
7. Test the parent business process model, monitoring the activity. If needed, modify the process model 

and repeat this step as needed.
8. Run the parent business process as needed.

Using the OnFault Group in the GPM
The GPM contains an OnFault Group in the BPML stencil. The OnFault Group may contain one onFault 
element or many onFault elements. In the Property Editor there is an Add button that will add additional 
elements as needed. Configure an onFault element by:

1. From the workspace, select the OnFault Group icon where you want to view an element editor.
2. To access the element editor where the onFault element can be modified or additional onFault 

elements can be added to the OnFault Group, select Properties from the Edit menu. 
3. Click in the Name or Error Value fields
4. Click the view button.
5. The Workspace will contain an OnFault Start and an OnFault End.
6. Add the process you want to run when the fault specified in the Error Value field occurs.
Note: The Error Value field must match an error in GIS for that element to execute. If you leave the Error 

Value field blank, all errors will execute that branch unless the specific error has its own element. 
The first onFault element could have a specific value and the second element could be blank. That 
way the specific error would execute the first element and all other errors would execute the second 
branch.
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About Implementing Business Process Models
After creating or modifying a business process model, you must perform implementation steps before 
running it in Gentran Integration Suite. The implementation process involves:

1. Validating the process model. For information, see Business Process Model Validation.
2. Creating a definition of the process model in Gentran Integration Suite. For information, see Creating 

a Business Process Definition.
3. Checking the process model in to Gentran Integration Suite. For information, see About Checking in 

Business Process Models.
4. Testing that the process works as planned. For information, see Testing the Business Process Model.

Use a test environment for checking in and testing your processes before you run them in your 
production environment.

Because implementing a process model often involves working with revised versions of pre-existing 
models, before you begin, review the information about version management. See Managing Business 
Process Model Versions.

Managing Business Process Model Versions
Version management is an important concern related to implementing your business process models. As you 
make multiple changes to existing process models and create variations of a process model, you need to be 
certain that the process model that runs is the appropriate version.

The first time you check in a business process, the data you enter creates a business process definition—a 
uniquely named copy of the process model to be stored in Gentran Integration Suite. The business process 
model stored in Gentran Integration Suite is independent of any .bp file of the process that you may have 
saved in a local directory. 

At any time, you can open an existing process model, modify and save it, and then either check in the new 
version to Gentran Integration Suite, or save the modified copy of the process in Gentran Integration Suite 
as a new process altogether. All previously checked-in versions of business process models continue to be 
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stored in Gentran Integration Suite. This enables you to revert to using an older version should the need 
arise.

For more information, see Modifying and Managing Business Process Models.

Business Process Model Validation
Gentran Integration Suite BPML validation feature checks for proper BPML syntax in your process models 
and looks for faulty design, to help you avoid common pitfalls that lead to processing problems. Your 
business process models must pass validation before you can enable them for use in Gentran Integration 
Suite. 

The following table describes the checks performed when you validate a business process model in Gentran 
Integration Suite:

You can validate your business process models in both the GPM and Gentran Integration Suite interface.

Validation Check Description

BPML syntax Verifies that the BPML comprising a business process model is valid XML. 

ForEach/Invoke Loop Verifies that a faulty document looping structure is not part of the business process 
model. The problem loop contains:

A For Each Document service

An Invoke Business Process service

This loop structure will fail validation unless the loop also contains:

An Assign activity to a message_to_child element that makes a specific reference to 
which document to use for the next cycle

A Release service targeting the value "message_to_child" (this keeps unneeded 
copies of documents from being created)

OR

One or more assign elements to message_to_child in the Message To Service of the 
Invoke Business Process service (in this case, the Release service is not needed)

An improper document loop structure unduly taxes the database and can lead to 
production down scenarios, particularly if you are processing large files. 
If the validation check finds this structure, it returns one of the following errors, depending 
on the structure: 

Node Validation Error:
Activity Name: Invoke Business Process Service
Validation Message: Document loop contains an InvokeBusinessProcess service 
without an assign to message_to_child.

Node Validation Error:
Activity Name: foreachSplitDoc
Validation Message: message_to_child not guaranteed to be released in document 
loop.
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✦ Validation in the GPM
In the GPM, you can save a business process model at any time and then validate it later, or you can 
configure the GPM to validate every time you save the file. By default, the GPM prompts you to 
validate a model when you save it (to disable or enable this behavior, select Preferences from the 
Options menu).
Because you may check in unvalidated process models or processes containing validation errors using 
the GPM, be sure to validate before check-in. Processes that are checked in but not valid are not 
executable. For more information, see Checking In a Single Business Process Model in the GPM.

✦ Validation in Gentran Integration Suite Interface
In Gentran Integration Suite interface, validation is part of the procedure for either checking in a 
process model created in the GPM or creating a business process model in the text editor. 

For more information about the types of check-in procedures, see About Checking in Business Process 
Models.

Validating Pre-existing Business Process Models
Any time you have upgraded your Gentran Integration Suite software and you want to re-validate previously 
implemented business process models using the upgraded application, simply check the process models out 
and check them back in again.

Creating a Business Process Definition
A business process definition is the name and some additional processing instructions that you assign to a 
business process model when you check it in to Gentran Integration Suite for the first time. 

You create the business process definition during the check-in process:

✦ During the Add (check in) process in the GPM 
✦ When you create a new process definition in Gentran Integration Suite interface

Create a definition only the first time you check in a business process model. Then, any time you check 
it out later and check it back in again, check in a new version of this definition, unless you want to save 
another copy of the business process model in Gentran Integration Suite, with a new name.

The name you assign in the process definition is the identifiable name used to indicate the process 
throughout Gentran Integration Suite interface and Gentran Integration Suite and GPM Source managers.

About Checking in Business Process Models
You can check in a business process model from within the GPM interface or through Gentran Integration 
Suite interface.
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Both Gentran Integration Suite interface and the GPM provide a Source Manager feature you use to check 
in a business process. The two Source Managers differ slightly, but both enable you check in new business 
process definitions and new versions of previously checked-in process models. Both display the current list 
of business process models and versions.

Each time you check in a business process, you create a version of the business process, either the first 
version of a new process model, or a new version of a previously checked-in business process model. 
Gentran Integration Suite saves each checked in version so that you retain a copy of every iteration of a 
process model that you check in. You cannot check in a version of a business process that is checked out 
and locked (protected) by another user.

The check in procedure differs depending on your goal and the application you are using. The following 
table describes the options and provides a link to appropriate instructions:

Testing the Business Process Model
Test your business process model before using it in your production environment. The validation step 
verifies only that the BPML structure is valid, it does not indicate invalid parameters or guarantee that the 
process works, so testing is important.

Use a test environment if possible. If Gentran Integration Suite reports errors, make appropriate corrections 
to the business process model or the service and adapter configurations in it. Retest the business process 
until it is working as needed in the test environment. 

Type of Check-In For Instructions, see:

Check in a new business process model in the GPM
Note: This applies to both original process models and any 

modified models you want to check in as a new process 
rather than as a version of an existing one)

Checking In a Single Business Process Model 
in the GPM

Check in new version of a business process model in the GPM Checking In a New Version of a Business 
Process Model in the GPM

Check in multiple business process models in the GPM Checking In Multiple Business Process Models 
in the GPM

Check in new business process model in Gentran Integration Suite 
interface 
Note: This applies to both original process models and any 

modified models you want to check in as a new process 
rather than as a version of an existing one.

Checking In a New Business Process Model 
Using Gentran Integration Suite Interface

Check in new version of a business process model in Gentran 
Integration Suite interface

Checking In a New Version of an Existing 
Business Process Version in Gentran 
Integration Suite

Check in a new or modified business process model from the text 
editor in Gentran Integration Suite

Checking In a Business Process Model Using 
the Text Editor
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When you are ready to implement the business processes in your production environment, you can export 
the resources from the test environment and import them into production. The ability to tag resources can 
expedite the automation of the export and import process. 

Remember that the flexibility of Gentran Integration Suite often enables you to choose from among many 
options to accomplish a given task. Test cycles will help you determine the most efficient methods for your 
needs.

For instructions for testing a business process model, see Testing a Business Process Model.

Business Process Model Processing Options
When you check in a business process model, the system prompts you to set a variety of processing options. 
You can configure archiving of related data, document storage and tracking, persistence levels, and many 
other features, according to your business needs. If you are using a clustered installation of Gentran 
Integration Suite, you can specify the specific node you want the process to run on.

Your selections may affect system performance, error handling, amount and type of data available for 
monitoring events, and so forth, so be sure to review the options described here before you check in a 
business process model, and determine which selections are appropriate for your needs (you can modify 
them as needed later by re-checking in the process model). 

Remember that some processing options can be set at the global level for the entire system and some within 
the BPML for a process model. These settings may or may not override settings you make at the business 
process level, depending on the options you choose. The field descriptions indicate which settings override 
other settings.

Process Name

Description

Field Description

Process Name Type a name that identifies the business process model. 
This is the business process definition name stored in Gentran Integration Suite. 

Field Description

Description Type a description that helps identify the business process you are creating. This is 
stored in Gentran Integration Suite with the version of the business process model you 
are checking in. If the process model is an updated version of a business process, you 
may want to note what you changed in this version, such as "added onfault step,” to help 
with future differentiation between checked-in versions.
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Process Levels

Field Description

Document Tracking Select this option if you want documents involved in this process model to be trackable 
according to the document tracking settings you have configured. Document tracking at 
the business process level is disabled by default, and this setting overrides the global 
document tracking setting. If you are not using Gentran Integration Suite document 
tracking features, leave the option disabled, to reserve system resources for other tasks.

Set onfault processing Select this option to the enable on-fault activity specified in the process to immediately 
execute in the event of a system error. 

Set Queue  Gentran Integration Suite enables you to set performance optimizations by queue, 
defining queue levels the system uses to allocate resources. Select the queue level that 
you want for this business process model for processing. The default value is 4.

Enable Async Start Mode Asynchronous initiation is selected by default. Starting business processes 
asynchronously is recommended. Asynchronous mode is standard Gentran Integration 
Suite processing, wherein the business process is placed in queue and processed. 
Note: Always use asynchronous mode, with one possible exception. If you are 

running this process in Sync mode, you must use synchronous start. You may 
be using Sync mode if, for example, you are using the MSMQ adapter, set to 
Embedded mode. Clear this check box to use synchronous mode. Sync mode 
functionality is limited in that your Persistence Level is Zero by default, and you 
cannot, therefore, manually restart or resume the process.

Enable Transaction Select this option to instruct Gentran Integration Suite to treat the entire process as a 
single transaction so that either all of the steps complete, or, in the event of an error, 
none of them do. When an error occurs, no data is committed; data returns to its 
pre-process state. 
Note: Enabling transactions applies only to services that support transaction mode. 

See the reference information for specific services to determine whether this 
option is supported.

By default, this transaction mode is not enabled.
Note: If transaction management is already built into the process model (the model 

includes Start and End Transaction services), do not select this option or the 
process will fail.

Commit All Steps when 
there is error

Select this option to have the business process commit all work to the database, at the 
time an error is generated. With this option you can either rollback or commit all work 
prior to the error before the onfault block is called.
If you select this option, all steps prior to the error are committed to database and the 
business process keeps running on the onfault block path. If you do not select this 
option, all steps prior to the error will be rolled back and the onfault block path is called. 
By default, this option is not enabled. 
Note: This option is valid when the BPML is configured with an onfault block and 

Enable Transaction is selected

Category You can optionally enter a category name to which this process model belongs, creating 
the category. The category does not affect processing; categories are for future product 
enhancements.
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Persistence Level The persistence level options enable you to specify, at the business process level, the 
types of data to retain in the database for the process whenever it runs. Persisted data 
can be crucial to process recovery in the event of errors and is useful for monitoring and 
tracking activities, including generating status reports. Persisted data may include any of 
the following types of data:

Status information for the steps in the process, which is comprised of:

- General status information for the steps (start and stop time, step name)
- Error information for failed steps
- Data describing the start and stop conditions of the process

Process data

Documents associated with the process 

The types of data persisted for a process depends on the activities the process involves 
(such as whether the process has documents associated with it) and your persistence 
level settings. 
Persistence can also be set globally (at the system level) for all processes; by default this 
is set to FULL persistence, although it may have been customized for your installation. If 
your installation uses the default FULL persistence for the system, you generally do not 
need to change persistence at the business process level unless you are seeking 
performance improvements. For the process model you are checking in, your selection 
here overrides the global persistence level set in the properties file. 
Note: Two exceptions may affect your persistence selection. First, remember that 

some services support only a limited selection of persistence settings, 
regardless of the level of persistence you assign to the process model. 
Second, any persistence overrides configured in the BPML for steps in the 
process model override the setting you make here for the specified step or 
steps.

Choose the option that provides the type of data you need for monitoring, tracking, and 
recovery in the event of a failure. Remember that persisting data can slow system 
processing by filling up the database. Consider your archive and purge settings in 
addition to the amount and type of data you intend to persist. 
For a detailed description of persistence setting options, see Persistence Options on 
page 61.

Field Description
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Event Reporting Level Select the level of events to generate for this process. Events are actions that occur 
within the system, such as adapters starting and stopping, business process status or 
state changes, and errors and exceptions, that are configured to generate event data. 
Gentran Integration Suite uses events for various features, such as event-driven 
notifications.
Note: Full event reporting is recommended to ensure that all of your system features 

operate correctly. Minimal or no event reporting settings are options that can 
improve system performance in some specialized circumstances; however, 
you should use these options only upon recommendation from Sterling 
Commerce Customer Support, when Support has determined that features 
dependent on events are not needed. 

The levels are:

Full – Generate all configured events for the business process, including the 
business process start and end time, start and end times for all services or adapters 
running as a result of this business process, and any resulting errors and exceptions. 
This is the default and recommended selection.

Minimal – Generate events for the business process, including the business process 
start and end time and any resulting errors and exceptions.

None – Do not generate any event reporting.

Recovery Level Select the level of recovery for this business process if the business process should be 
interrupted during execution. The levels are:

Auto Resume – Resume the business process at the last point at which the business 
process was persisted.

Auto Restart – Terminate the current business process and restart it from the 
beginning.

Terminate – Terminate the business process.

Manual – Take no action automatically. With this option, you must resume or restart 
the business process manually. This is the default selection.

Document Storage Select the document storage type for document payload data written when the business 
process runs. The options are:

Database – Store documents in the database. Use this option for small documents or 
when clustering without a clustered file system.

File System – Store documents in the file system. This option may be best for large 
documents (over 10 MB). Using this method, you must handle archiving and purging 
the documents from your file system.

Archiving and purging from the file system may require special handling. 

System Default – Use the option configured in the jdbc.properties file. This is the 
default document storage setting for process models. As shipped, Database is the 
document storage type configured in the jdbc.properties file; it may be modified for 
your installation to use the file system. 

Inherited – When one document is created as a result of another, the new document 
uses the previous document’s storage type.

Field Description
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Persistence Options
The following table describes the persistence options and indicates the types of data persisted for each:

Enable BP Execution 
Settings

This option displays only when you are using a clustered Gentran Integration Suite 
environment. Select this option to display the available choices for specifying the node to 
run the process on. If you do not specify a node, the system uses any available node. To 
select a node:
1 In the Select Node field, select the node on which you want the process to run. 
2 In the Execution Node Specific field, specify whether the process must run on 

the selected node or can use others. Options are:
Preferred Node – Run the process on the selected node unless the node is 
unavailable (inactive for some reason).
Mandatory Node – Always run the process on the selected node (if the node is 
unavailable for some reason, the process will fail).

Note: The Execution Role Specific field is reserved for future use.

Persistence 
Level

Description Start and 
Stop 
Steps 
Data

Services 
Steps 
Status 
Data

Errored 
Steps 
Data

Process 
Data

Docs

Full Retains all data for this business 
process model. This selection uses the 
most system resources of any 
persistence level setting.

Yes Yes Yes Yes Yes

Step Status - 
Engine May 
Override 

This is the recommended persistence 
level for most process models because it 
helps optimize performance while 
providing a level of recovery suitable for 
most business needs. 
* Persists process data and documents 
for service steps according to the 
persistence level supported by the 
service in the step. 

Yes Yes Yes Possibly* Possibly*

BP Start 
Stop  -  
Engine May 
Override

Choose this level if you know you do not 
need persisted status data for successful 
processing. Because service level 
settings override the selection, you may 
have additional data in a recovery 
scenario.
* Persists process data and documents 
for service steps according to the 
persistence level supported by the 
service in the step. 

Yes No Yes Possibly* Possibly*

Field Description
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System 
Default

This is the default selected persistence 
level.
* Persists data according to the global 
persistence setting configured in the 
properties file. 

Possibly* Possibly* Possibly* Possibly* Possibly*

Step Status 
Only

Choose this level if you need only status 
information for each step and your 
recovery needs do not depend on 
additional data being saved. 

Yes Yes Yes No No

BP Start 
Stop Only

Choose this level if your recovery needs 
do not depend on data being saved for 
the processing steps.

Yes No No No No

Zero This level does not persist any business 
process data you for recovery or process 
tracking. Choose this level only if you are 
certain you will not need the data.
Note: Zero persistence is available 

only if the process is running 
in Synchronous start mode.

No No No No No

Error Only Choose this level if you do not need 
tracking data for your process when it is 
successful and your recovery does not 
depend on process step data being 
saved.

Only in 
case of 
errors

Only in 
case of 
errors

Yes Only in 
case of 
errors

Only in 
case of 
errors

Persistence 
Level

Description Start and 
Stop 
Steps 
Data

Services 
Steps 
Status 
Data

Errored 
Steps 
Data

Process 
Data

Docs
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Gentran Integration Suite Deadline Settings
A Deadline Setting allows you to specify a time for a business process (that is not in a state of ACTIVE) to 
move to the front of the queued business processes waiting to run. Doing this notifies the system to place 
the business process in queue to move to the front of the queue. Every effort will be made to run the business 
process at the front of the queue. If the business process in queue misses its queue and reaches the first and 
second deadline, an exceptional event will be fired and posted to the dashboard. In order for you to receive 
the notification, you need to define the event posted to dashboard by setting EnableDeadlines=true in 
noapp.properties for each queue and define the eventrule in the eventrule.properties file. 
EnableDeadlines.1=true for queue 1.

To set the Deadline Setting, set it for the number of hours or minutes from the business process start time. 
By default deadline and notifications are not set. To modify a Deadline Setting, you must modify the 
business process by checking the business process out, then check it back in.

Deadline Settings:
Select the appropriate setting. 

Additional Setup Procedures for Deadline Notifications (for business processes in 
queue)
Deadline Notification also requires additional setup for these property files:

1. Uncomment rule1 and rule2 in eventrules.properties

Uncomment the following two sets of rules to turn the # on Event Notification.
name.rule1 = RuleEventAbnormal
expression.rule1 = "/event[contains(ExceptionLevel,&apos;Abnormal&apos;) or 
contains(ExceptionLevel,&apos;ABNORMAL&apos;)]"
action.rule1.1 = com.sterlingcommerce.neo.event.rule.BPSpawnerAction
priority.rule1 = 3

name.rule2 = RuleEventExceptional
expression.rule2 = "/event[contains(ExceptionLevel,&apos;Exceptional&apos;) or 
contains(ExceptionLevel,&apos;EXCEPTIONAL&apos;)]"
action.rule2.1 = com.sterlingcommerce.neo.event.rule.BPSpawnerAction

Field Description

Do not set deadline Run the business process without a deadline for queued business processes. This is the 
default selection. 
To run a queued business process on a deadline, clear the check box.

Complete by Deadline Enables you to specify a deadline time, in hours and minutes, by which the business 
process must complete once it is put in a queue. 
Note: The deadline setting applies as long as the business process remains in a 

queue and does not apply for running business process.

First Notification: Hours 
and Minutes

Enables you to specify whether to receive notification before a business process 
deadline (as long as business process remains in a queue).

Second Notification: 
Hours and Minutes

Enables you to specify whether to receive another notification before a business process 
deadline (as long as business process remains in a queue).
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priority.rule2 = 4

2. Confirm rules listener setting in listenerStartup.properties.

# rule listener
Listener.Class.3=com.sterlingcommerce.woodstock.event.listeners.rule.RuleListener

3. The user wishing to receive these notifications needs to belong to the following groups

Abnormal Event Notifications 

Exceptional Event Notifications 

Life Span
Use these options to:

✦ Indicate the length of time that data pertaining to each instance of this business process model will 
remain in the system after the process has completed, to be available for monitoring, tracking and 
reporting activities.

✦ Specify whether to archive or purge the process-related data when the life span expires.

Set Default Version
This option displays only if you are checking in a business process model for which one or more other 
versions are already saved in Gentran Integration Suite.

Field Description

Process Specific Enter the number of days or hours, or days and hours combined, that data for each 
instance of this business process model are permitted to remain in the system.

Expired Business 
Processes should be

Select either Archived or Purged for expired data. Archived data is stored in your file 
system.

System Default Select this option if you want the data for instances of this business process model to 
expire and be archived after two days. This option is configurable.

Field Description

Default Version Indicates the version of this business process model that is currently saved and 
designated in the system as the default version (the version the system runs unless 
otherwise specified). 
If you do not want this version of the process model to remain the default, select the 
version you are checking in, in the OTHER Versions field.

OTHER Versions Lists the version you are checking in and any other versions saved in Gentran Integration 
Suite. Select the version you want to be the default.
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Confirm

Checking In Business Process Models Through the GPM
Checking in business process models involves setting a variety of processing options. Before you check in 
a business process model, determine the appropriate options. For information, see Business Process Model 
Processing Options.

The check-in procedure you use with the GPM Source Manager differs somewhat depending on what you 
need to do. Select the procedure that applies to your situation:

✦ Checking In a Single Business Process Model in the GPM
✦ Checking In Multiple Business Process Models in the GPM
✦ Checking In a New Version of a Business Process Model in the GPM

Checking In a Single Business Process Model in the GPM
This procedure assumes that you have validated and saved the business process model using the GPM. 

To check a single business process model in to Gentran Integration Suite:

1. In the GPM, select Tools > Source Manager.
2. Type the same user ID and password that you use when logging in to Gentran Integration Suite.
3. In Source Manager, select Process > Add.

For the remaining steps, the order of the fields that display may differ, depending on whether your 
GPM settings specify Expert Mode for the Source Manager. If you did not specify Expert Mode, click 
Next to display the following fields.

4. Enter the appropriate values in the following required fields:

Process Name – see Process Name.

Field Description

Enable Business 
Process

Makes the process model available to run. The business process model is enabled by 
default. If you are not ready to run the process, clear the check box.

Release the lock on the 
file

(Displays only if you are checking in a new version of a pre-existing process model that is 
locked.) Clear the check box if you want the pre-existing version of the process model to 
remain locked.

Create Permission Select this option to have a permission selection created for this business process model 
automatically. The permission can be assigned to user accounts to enable or restrict 
user access to running the process. Permissions are optional. If none are assigned, the 
process is available for all users. 
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File Name – Browse to select the business process document (.bp file) from the directory on your 
client computer where you saved it.

Description – see Description.

Start Mode – see Enable Async Start Mode.

Transaction Level – see Enable Transaction.

Set Queue – see Set Queue.

Persistence Level – see Persistence Level. 

Event Reporting Level – see Event Reporting Level.

Recovery Level – see Recovery Level.

Document Storage – see Document Storage.

Preferred Node – If you are using a clustered Gentran Integration Suite environment and you want 
to assign a specific node on which you prefer this process model to run, select the node. Otherwise, 
the field defaults to a value of None. For more information, see Enable BP Execution Settings.

Mandatory Node – If you are using a clustered Gentran Integration Suite environment and you 
want to assign a specific node on which this process model must run, select the node. Otherwise, 
the field defaults to a value of None. For more information, see Enable BP Execution Settings.

Category – see Category.

5. Indicate deadline settings for the business process to run. See Gentran Integration Suite Deadline 
Settings.

6. Indicate archiving information for the data you are retaining. See Life Span.
7. Select validation options: 

Select Validate Process to validate the process model now. 

Validate Process is activated by default, but is optional. Successfully validated business process 
models are checked in and enabled for use in Gentran Integration Suite. When validation errors 
occur during GPM check-in, Source Manager checks the model in, but it will not be enabled for 
use, and errors are not reported. Therefore, be sure to validate the process before checking it in. 
Otherwise, a process containing validation errors cannot be invoked until the errors are resolved.

Select Enable Process to enable the business process to run in Gentran Integration Suite. If 
Validate Process is not selected, you cannot enable the business process model.
If you do not enable the business process, you cannot run it in Gentran Integration Suite without 
first enabling it later. For instructions to enable it independently of the check-in procedure, see 
Enable a Disabled Business Process.

8. Specify whether you want Gentran Integration Suite to track the progress of the document when the 
business process runs. See Document Tracking.

9. Specify whether you want the business process to run its onFault protection should the business 
process encounter an error when it is running. See Set onfault processing.

10. Click Finish.
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You can now run your business process in Gentran Integration Suite. Test the business process before 
running it in your production environment. For information, see Testing a Business Process Model.

Checking In Multiple Business Process Models in the GPM
You cannot specify processing options for individual business process models when you check in more than 
one of them in the same check-in procedure. However, this method can be convenient when you do not need 
to set the options. For details about the processing options you can set when you use the single check-in 
procedure, see Business Process Model Processing Options.

Before adding multiple business processes at the same time, consider that:

✦ Gentran Integration Suite automatically sets each business process model you are checking in as the 
default version for that process model, and enables it for execution. Do not check in multiple process 
models if you do not want each of them to be the default processes. 

✦ An invalid business process cannot be selected as a default business process, therefore Gentran 
Integration Suite does not check in multiple process models if one or more of the models you are 
checking in has not been successfully validated.

✦ Gentran Integration Suite applies the system default archiving configuration already defined in 
Gentran Integration Suite to each business process, including:

The queue setting (this allocates resources related to the order in which business processes are 
processed)

Level of persistence for retaining business process data

Length of time (days and hours) to retain archived business process data

Procedure
To check multiple business process models in to Gentran Integration Suite at the same time:

1. For each business process model that you want to check in:

Open the file.

Validate the process model (select Build > Validate).

If any business process model is invalid, Source Manager prevents you from checking in multiple 
business processes at the same time.

Save the process model (.bp file). 

Save all of the files in the same directory on your client computer.
2. In the GPM, select Tools > Source Manager.
3. In the Log In dialog box, type the same user ID and password that you use when logging in to Gentran 

Integration Suite.
4. In Source Manager, select Process > Add All.
5. In the Directory field, specify the path to the directory from your client computer where you saved the 

business process models (.bp files). To do this, click ... to browse to the folder, if needed. Click on the 
folder name that contains the files, and click Select, without opening the folder. Then the contents of 
the selected folder display in the left pane for you to select in the next step.
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6. From the left pane, complete one of the following steps:

To select one business process model at a time from the directory, select the .bp file, and then click 
the right arrow. Repeat as necessary.

To add all the business process models from the directory at once, click the right double-arrows.

7. Click OK.

You can now run your business process models in Gentran Integration Suite. Test the business processes 
before running them in your production environment. For information, see Testing a Business Process 
Model.

Checking In a New Version of a Business Process Model in the GPM
This process assumes that you have checked out a business process model and modified and validated it.

To check in an updated version of a previously checked-in business process in the GPM:

1. In the GPM, select Tools > Source Manager.
2. In Source Manager, select the business process model name from the left pane (not the version) to 

check in, and select Process > Check In. 

If the Check In option is not active, one of the following is true:

No version of the selected process model is currently checked out.

You have not refreshed the Source Manager with the most current list of process models (that is, 
since you checked out a new version). To do this, select View > Refresh.

3. Complete the following required fields:
For the following fields, your display may differ, depending on whether you specified Expert Mode for 
the Source Manager through the GPM. If you did not specify Expert Mode, click Next to display the 
following fields.

Process Name – see Process Name.

File Name – Select the business process document (.bp file) from the directory on your client 
computer where you saved it.

Description – see Description.

Set Queue – see Set Queue

Persistence Level – see Persistence Level.

Event Reporting Level – see Event Reporting Level.

Recovery Level – see Recovery Level.

Document Storage – see Document Storage.

4. Indicate deadline settings for the business process to run. See Gentran Integration Suite Deadline 
Settings
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5. Indicate whether you want this version to be the default version that Gentran Integration Suite runs. If 
you want a different version to be the default version, select Let me select a different version, select 
the version you want from the display, and click Next.

6. Indicate archiving information for the data you are retaining. See Life Span.
7. Select validation options: 

Select Validate Process to validate the process model now. You cannot check in if you do not 
validate.

Select Enable Process to enable the business process to run in Gentran Integration Suite. If 
Validate Process is not selected, you cannot enable the business process model.
If you do not enable the business process, you cannot run it in Gentran Integration Suite without 
first enabling it later. For instructions to enable it independently of the check-in procedure, see 
Enable a Disabled Business Process.

Indicate whether you want to release the lock on this process model so that it can be run in Gentran 
Integration Suite or modified by other users.

8. Specify whether you want to track the progress of the document when the business process runs. 
Document Tracking on page 58.

9. Specify whether you want the business process to run its onFault protection should the business 
process encounter an error when it is running.

10. Click Finish.

You can now run your business process in Gentran Integration Suite. Test the business process before 
running it in your production environment. For information, see Testing a Business Process Model.

Checking In a Business Process Model Using the Text Editor
You check in a business process model using Gentran Integration Suite text editor only if you are creating 
or modifying the model in the editor. You can indicate whether the want the model to be the default model.

This check-in option is part of the larger process of creating or modifying a business process model using 
the text editor. For information, see the appropriate procedure:

✦ Creating and Modifying Business Process Models In the Text Editor
✦ Modifying a Business Process Model Using the Text Editor

Checking In a New Business Process Model Using Gentran 
Integration Suite Interface
Use this procedure if you want to check in a process model that you:

✦ Just created and saved in the GPM
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✦ Checked out of Gentran Integration Suite, modified and saved in the GPM, and want to check into 
Gentran Integration Suite as a new business process model (not as a version of an existing model)

Before you check in a business process model, consider the processing options you will want to associate 
with it. For information, see Business Process Model Processing Options.

To use Gentran Integration Suite interface to check in a new business process model saved in the GPM:

1. From the Business Process menu, select Manager.
2. In the Create section, click Go!
3. Type a name that helps identify the business process definition you are creating. See Process Name.
4. Under Select an input mode for defining the new process, select Check-in Business process created 

by the graphical modeling tool and click Next. 
5. Select the business process document (.bp file) from the directory on your client computer where you 

saved it.
6. Type a description that helps identify the business process you are creating and click Next. See 

Description.
7. Specify whether you want to track the progress of the document when the business process runs. See 

Document Tracking.
8. Specify whether you want the business process to run its onFault protection should the business 

process encounter an error when it is running. Set onfault processing
9. For Set Queue, indicate the queue, previously defined to allocate resources, at which to place this 

business process for processing. See Set Queue.
10. Indicate the level of persistence to retain data that makes up the business process. See Persistence 

Level.
11. Indicate the level of event reporting that you would like or this business process when it runs. See 

Event Reporting Level.
12. Indicate the level of recovery for this business process if the business process should halt during 

execution. See Recovery Level.
13. Indicate the level of document storage for documents that process when the business process runs. See 

Document Storage.
14. Indicate deadline settings for the business process to run. See Gentran Integration Suite Deadline 

Settings.
15. Click Next and indicate the life span (archiving information) for the level of persistence data you are 

retaining. See Life Span.
16. To enable the business process to run, click Next, and verify that the check box next to Enable 

Business Process is selected.
17. To create a permission, select Create Permission, and then click Finish. 

18. Click Finish.
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Checking In a New Version of an Existing Business Process 
Version in Gentran Integration Suite
Use this procedure to check in a new version of business process model that has been previously saved in 
Gentran Integration Suite (meaning, it already has a business process definition) and that has now been 
modified. During checkin you will indicate which saved version will be the default version.

Note: You cannot check in a new version of a business process model if you do not own the lock on the 
pre-existing model; that is, if you are not the user who checked the process model out prior to this 
attempt to check in the new version.

To check in a new version of an existing business process model:

1. From the Business Process menu, select Manager.
2. Use the List or Search options to locate the process model you want to check in.
3. Next to the name of the business process model for which you are checking in a new version, click 

source manager.
4. Click Go! next to Check-in an updated definition for this Business Process. 

You can also click check-in next to a business process to disable the lock and check in a business 
process.

5. Select the business process document (.bp file) from the directory on your client computer where you 
saved it.

6. Type a description that helps identify this version of the business process. See Description.
7. Specify whether you want to track the progress of the document when the business process runs. See 

Document Tracking.
8. Specify whether you want the business process to run its onFault protection should the business 

process encounter an error when it is running.
9. For Set Queue, indicate the queue level. See Set Queue.
10. Indicate the level of persistence to retain data that makes up the business process. See Persistence 

Level.
11. Indicate the level of event reporting that you would like for this business process. See Event Reporting 

Level.
12. Indicate the level of recovery for this business process if the business process should halt during 

execution. See Recovery Level.
13. Indicate the level document storage for documents that process when the business process runs. See 

Document Storage.
14. Indicate deadline settings for the business process to run. See Gentran Integration Suite Deadline 

Settings.
15. Click Next and indicate the life span (archiving information) for the level of persistence data you are 

retaining. See Life Span.
16. To compile the business process data, click Next.
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17. To make this business process the default version, click Next and select the business process under 
OTHER Versions.

18. To enable the business process to run, click Next and verify that the check box next to Enable 
Business Process is selected.
If you choose not to enable this business process, clear the Enable Business Process check box. 

19. To unlock the business process, verify that the check box next to Release the lock on the file is 
selected.

20. To create a permission associated with this business process model, select Create Permission, and 
click Finish. 

21. Click Finish.

Testing a Business Process Model
Before running it in your production environment, test a new business process model or new version of a 
process model by manually running it, or configure it to run on a schedule. If possible, test your business 
process in a test Gentran Integration Suite environment.

One testing method is to test the business process using sample input data by starting the business process 
manually. 

Retest the business process until it is working as needed. 

Procedure
This process assumes that you have checked in and enabled the business process model that you are testing.

To test a business process:

1. From the Business Process menu, select Manager.
2. Type all or part of the name for the business process you want to test into the Search box and click 

Go!
3. Next to the business process you want to test, click execution manager.
4. On the Execution Manager page, ensure that the business process you want to run is enabled and set as 

the default version. 
5. Click execute to open the Execute Business Process Input page.
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6. Specify the following input parameters, as appropriate, and click Go!:

Gentran Integration Suite runs the selected version of the business process and opens the Execute 
Business Process page.

After you initiate the process model, you can monitor the processing activities. 

Field Description

Local Desktop 
filename

Name of your client computer where the file is stored. If it is stored on the client computer, 
select a directory on your client computer where the file is stored. If the file is stored on the 
host computer, go to the UNIX command line and type the command to specify the directory 
where the file is saved. Optional.

Server filename Name of the host server for your client computer. Optional

Encoding Type Character encoding for the business process. Optional. Valid values are:

[Not Applicable] 

UTF-8 ISO-8859-1 

ISO-8859-5 

US-ASCII 

ISO_8859-1 

EUC-JP UTF-16 

ISO-2022-JP

Run As User Assume user-rights of another user in order to run this particular business process. The 
default user is Admin; therefore, if you do not change the user in this field, whomever runs 
this business process will have the same rights as an admin user. Optional.

Input data is not 
required, click Go to 
continue. 

File the business process requires as input. Optional.
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Modifying and Managing
Business Process Models

Business Process Version Management
Both Gentran Integration Suite interface and the GPM provide access to work with your process models 
through the Source Manager. The Source Manager is a version management tool for saving copies of your 
process models into Gentran Integration Suite system, separately from any location on your client computer 
where you may have also saved them. It works as follows:

✦ When you create a process model, you cannot run it in Gentran Integration Suite until you have 
checked it in. The check-in procedure stores it for the Source Manager. 

✦ While you can save process model .bp files to your client computer at any time, to manage versions in 
Gentran Integration Suite you must use the Source Manager as your file management system. 

✦ To work with existing business process models, you must check them out through the Source Manager 
in order to lock the model against other users modifying it at the same time. 
Note: If you click Edit in the interface and modify a process model without checking it out, this locks 
the process.

✦ When you complete your modifications, you check in the now-updated process model. Rather than 
over-writing your existing copy of the model saved in the Source Manager, the system saves a new 
version. 

Gentran Integration Suite saves all previously checked-in versions of business process models. Therefore, 
a single process model may have many available versions listed in the Source Manager. One version is the 
designated default version. The default version is the version that Gentran Integration Suite automatically 
runs when the business process model is invoked. Retention of all versions enables you to revert to using an 
older version should the need arise, and saves you having to maintain versioned backup files on your client 
computer. 

The Source Manager determines versions by filename, as follows:

✦ While separate versions of a process model are different configurations, the filename of each is the 
same. 

✦ In the Source Manager, the system displays the date and time each version was checked in, to help you 
differentiate them. 
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✦ You can add additional identifying information in the Description field when you check in a process 
model to include more reference data about a version, such as indicating the need this version fills. 
This information displays in the Source Manager list in the interface.

✦ Assigning a new name to a process model at check-in creates a new model. The new model will have 
its own set of versions if you make additional changes to the file.

Working in the GPM, the Source Manager displays a file system-type list of the process models saved in 
the system. Working in the interface, you use search or list tools to locate a process model and access the 
source manager for the selected process model. The following figure illustrates the Source Manager:

When you check in an updated version of a business process model, you indicate which version is the default 
version in Gentran Integration Suite. 

The ability to specify a default version enables you to let bootstrap adapters run the default version of a 
business process model as needed, while other versions can be reserved for later use or be configured to run 
on a preset schedule. Any time you manually start a business process, you can select the version to run.

GPM

Interface

All checked-in 
process models are 
listed. Click here to 
display versions for a 
model
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Checking Out a Business Process Model Using the GPM Source Manager
Generally, when you check out a business process model, Gentran Integration Suite locks the process model 
so that other users and the system can not access it until you check it back in. If you plan to use an existing 
business process model as a foundation for a new model altogether, you can check out the model without 
locking it.

For instructions for checking out business process models, making modifications, and managing your 
versions of business process models, see the appropriate topic as indicated in the following table:

Checking Out a Business Process Model Using the GPM 
Source Manager
The Source Manager in the GPM enables you to check out one or many business processes at a time. Use 
the appropriate procedure.

Task For Instructions, see:

Check out a business process model in the GPM Checking Out a Business Process Model Using the GPM 
Source Manager

Check out a business process model in Gentran 
Integration Suite interface

Checking Out a Process Model in Gentran Integration 
Suite Interface

Modify a business process model in the text editor Modifying a Business Process Model Using the Text 
Editor

Modify a business process model in the GPM Modifying a Business Process Model Using the GPM

Delete a business process model from Gentran 
Integration Suite

Delete a Business Process Model

Enable a disabled business process version Enable a Disabled Business Process
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The following figure shows an example of the GPM Source Manager: 

The GPM Source Manager displays an alphabetical list of checked-in business process models. You can 
expand each process model name to view a list in the left pane of checked-in copies of that model, organized 
by checkin date and time (these are versions of the business process model). The right pane displays the 
following information for a selected version of a business process model:

✦ Date and time the version was last modified
✦ User name of the user who last saved the version
✦ Any description saved with the version at check-in

Check Out a Single Business Process Model
To check out a business process using the GPM:

1. From the Tools menu, select Source Manager.
2. Type the same user ID and password you use to log in to Gentran Integration Suite.
3. In Source Manager, select a business process and select Process > Check Out.
4. Specify a directory on your client computer in which to save the business process model (.bp file). 

Note: If you specified a file location using the GPM preferences, you do not need to perform this step. 
To set a default file location from the GPM, select Options > Preferences > File Location.

5. Indicate a new file name for the business process model when necessary. For example, to create a new 
version of a business process, indicate a new name that helps identify the version. See Process Name.
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6. To prevent other users from checking out this business process, verify that the Lock Business Process 
option is selected. If you do not want to lock the process, clear the check. If you are creating a new 
business process model but want the model you are checking out to remain as-is in Gentran Integration 
Suite, you do not need to lock the process model.
A lock symbol displays beside the business process when protected.

7. Click OK twice. The business process is checked out and you can open it in the GPM by:

Selecting File > Open

Navigating to the directory where you saved the checked-out model

Selecting the model and clicking Open.

Check Out Multiple Business Process Models
To check out multiple business processes at once:

1. From the Tools menu, select Source Manager.
2. In the Log In dialog, enter your Gentran Integration Suite user ID and password.
3. In Source Manager, double-click the parent folder to display all business processes in the right pane.
4. Complete one of the following steps:

To select more than one business process, click to select the business process from the right pane. 
Press and hold Ctrl and click again for each additional business process that you want to select.

To select a range of business processes, click the first business process in the range from the right 
pane. Press and hold Shift and click the last business process in the range.

5. From the Process menu, select Check Out.
6. Specify a directory on your client computer in which to save the business process models.
7. To prevent other users from checking out these business processes, verify that the Lock Business 

Process option is selected and click OK.
A lock symbol displays beside the business process when protected.

Checking Out a Process Model in Gentran Integration Suite 
Interface
When you check a business process model out of Gentran Integration Suite, you save it to your client 
computer. You can then open the checked-out .bp file in the GPM (editing a business process model in the 
interface uses a different check-out procedure; for that procedure, see Modifying a Business Process Model 
Using the Text Editor).

During the check-out procedure, Gentran Integration Suite prompts you to lock the business process. 
Locking the business process not only prevents others from checking out the same business process, it also 
prevents the possibility of inadvertently replacing an existing business process. If you do not lock the 
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process in Gentran Integration Suite, you cannot check in a new version of it, although you can check it in 
as a new process model.

You can also check out a read-only copy of the process model. Using the read-only copy enables you to 
view and modify the business process model (in the GPM only, until you check it in to Gentran Integration 
Suite), but you must save it with a new name. Use this option if you want to create a new business process 
model using an existing one as the basis for it.

Procedure
To check out a business process model:

1. From the Business Process menu, select Manager.
2. Type all or part of the name for the business process you want to modify into the Search box and click 

Go!
3. Click source manager next to the business process you want to modify.
4. Click check out next to the business process.
5. Determine whether to lock the file by completing one of following steps:

To check out the business process for modification, click OK. Use this option to create an updated 
version of the process model in the GPM or the text editor.

To check out a read-only copy of the business process without locking it, click Cancel. Use this 
option to view the model in the GPM or to use it as the foundation for a new business process 
model (in this case you must open it in the GPM and save it with a new name).

6. In the File Download dialog box, click Save.
7. In the Save as dialog box, select a directory on your client computer and click Save to begin 

downloading the business process document.
8. When the download completes, close the Download dialog box, if it remains open.
9. Open the directory where you downloaded the file for the business process and open the file in the 

GPM to begin modifying it.

After you have modified a business process model, you must check it back in to Gentran Integration Suite 
so that you can run it. For information, see Implementing a Business Process Model.

Modifying a Business Process Model Using the GPM
To modify or reuse a business process that is currently checked in to Gentran Integration Suite:

1. Check out the business process. See Checking Out a Business Process Model Using the GPM Source 
Manager.
The check-out process enables you to save the business process to your client computer. You can then 
open the checked-out .bp file in the GPM and modify the business process model. You can change the 
processing options for the model when you check it back in, if needed (in step 3 below).
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2. Follow the general instructions for business process creation to modify your business process model 
(see Creating or Modifying a Business Process Model in the GPM).

3. When finished, check the new version in to Gentran Integration Suite. For information about 
implementing new versions of business process models, see About Checking in Business Process 
Models.

Modifying a Business Process Model Using the Text Editor
Note: If you do not need to modify the BPML but only need to change processing options, skip step 6. By 

doing this, you check the process out and then immediately begin the check-in procedure where you 
can set the processing options.

To modify a business process model in the text editor:

1. From the Business Process menu, select Manager.
2. Type all or part of the name for the business process you want to edit into the Search box and click 

Go!
3. Click source manager next to the business process you want to edit.
4. Click edit next to the business process to access the text editor. This checks out the process and locks 

it.
5. Type a new description that helps you identify this version of the business process. See Description on 

page 57.
6. In the Business Process field, either type or copy and paste BPML code that you want to edit.
7. Click Validate to validate the process model. You cannot enable a business process until it is 

validated.
A system message indicates whether the process is valid or invalid.

8. Is the process valid?

If No, correct invalid BPML code and repeat step 7 as necessary. You can view error information 
by clicking the link in the error message.

If Yes, click Next.

9. Specify whether you want to track the progress of the document when the business process runs. See 
Document Tracking on page 58.

10. Specify whether you want the business process to run its onFault protection should the business 
process encounter an error when it is running. 

11. For Set Queue, indicate the queue, previously defined to allocate resources, at which to place this 
business process for processing. See Set Queue.

12. Indicate the level of persistence to retain data that makes up the business process. See Persistence 
Level.

13. Indicate the level of event reporting that you would like for this business process. See Event Reporting 
Level.
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14. Indicate the level of recovery for this business process if the business process should halt during 
execution. See Recovery Level.

15. Indicate the level document storage for documents that process when the business process runs. See 
Document Storage.

16. Indicate deadline settings for the business process to run. See Gentran Integration Suite Deadline 
Settings.

17. Click Next and indicate the life span (archiving information) for the level of persistence data you are 
retaining. See Life Span.

18. To compile the business process data, click Next.
19. To enable the business process, verify that Enable Business Process is selected.

If you do not enable the business process, you can not run it in Gentran Integration Suite without first 
enabling it later. For instructions to enable it independently of the check-in procedure, see Enable a 
Disabled Business Process.

20. If you want to create a permission associated with the business process model, select Create 
Permission, and then click Finish. 

Enable a Disabled Business Process
Complete this procedure if you want to run a business process model that is disabled for use:

1. From the Business Process menu, select Manager.
2. In the List section, select the first letter of the name of the business process you need to enable, and 

click Go!
3. Next to the name of the business process to enable, select Execution Manager.
4. Select Enable and click Return.

Delete a Business Process Model
In Gentran Integration Suite, you can delete individual business process models (except system business 
process). Some reasons you might delete a business process model are:

✦ Business activities have changed and as a result a process model can no longer accomplish the 
activities.

✦ You need to remove unused versions of business process models to reduce database size.
Not all users can delete business process models. The ability to delete is governed by a permission setting 
in your user account. Only user accounts that have UI Delete Business Processes permission can delete 
business processes. 
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Considerations
Before deleting a business process model, consider that:

✦ Deleting a business process model is permanent; you cannot restore a deleted process model. Use the 
Export Resources function to save a copy of the business process to offline storage.

✦ If the business process model runs on a schedule, Gentran Integration Suite deletes the schedule with 
the business process. 

✦ After you confirm that you want to delete a business process (during the delete procedure), Gentran 
Integration Suite deletes the business process and creates a log entry. The log entry contains the name 
of the business process, date and time of deletion, and the account information of the user who deleted 
the business process.

Procedure
Caution: Identify any uses of the business process model to ensure that deleting it does not prevent other 

business processes and subsequent services from running.

To delete an individual version of a business process or all versions of a business process:

1. From the Business Process menu, select Manager.
2. Search for the business process you want to delete.
3. In the Business Process Manager search results page, click source manager next to the appropriate 

business process model.
4. Do you want to delete one version of the business process, or all versions of the business process 

model?

To delete one version of the business process model:

a. Next to the version, under Delete, select the check box.
b. For Delete Selected Versions, click Go!

To delete all versions of this business process model, next to Delete All Versions, click Go!
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Appendix A

Commonly Used Predefined Process Models

To help you accomplish business goals, Gentran Integration Suite provides a number of predefined business 
processes that you can use when creating business process models for your own business processes. After 
determining business goals and identifying the activities that enable you to meet the goals, you can either 
use the predefined business processes or create your own business processes. 

This topic describes some common business goals and predefined business processes provided in Gentran 
Integration Suite that enable you to easily achieve the goals. This section provides the following types of 
information:

✦ Description of each business process
✦ Activities that each business process performs
✦ Adapters and services that accomplish the activities
✦ Specifications that Gentran Integration Suite may require before you can use a predefined business 

process
The following table lists business goals and the predefined business process that accomplishes the goals:

Business Goal Business Process For More Information, 
See

Extracts ACH (Automated Clearing House) documents, such 
as a Payment Order/Remittance Advice Transaction Set 
(820), from an CTX interchange-level envelope and locates 
an associated contract, according to the content of the 
documents. ACHDeenvelope then starts the appropriate 
business process. 

ACHDeenvelope ACHDeenvelope Business 
Process

Applies an CTX transaction-level envelope to one or more 
ACH documents. Next, the ACHEnvelope wraps the 
document in an CTX group-level envelope and wraps the 
group-level envelope in an CTX interchange-level envelope. 
ACH Envelope then uses the interchange-level envelope 
data to locate the associated contract and start the 
appropriate business process. 

ACHEnvelope ACHEnvelope Business 
Process

Extracts CII messages from a message group in an EDI 
document. Gentran Integration Suite then reads the CII 
message to determine the next action to perform.

CIIDeenvelope EDI Deenvelope Business 
Process
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ACHDeenvelope Business Process
The ACHDeenvelope business process performs the following primary activities:

1. The ACHDeenvelope service splits documents into interchanges and puts delimiters sent into the 
process data.

2. Depending upon configuration, the service either looks up a contract or runs a business process.

Extracts EDI documents from an EDIFACT interchange and 
locates an associated contract, according to the content of 
the envelopes. EDIFACTDeenvelope then starts the 
appropriate business process.

EDIFACTDeenvelope EDI Deenvelope Business 
Process

Enables Gentran Integration Suite to process incoming 
SOAP messages.

HandleSOAPReques HandleSOAPRequest 
Business Process

Identifies EDI documents that maintain the state waiting in 
Gentran Integration Suite. The state waiting often indicates 
that an acknowledgment is overdue. 

OverdueAckCheck OverdueAckCheck 
Business Process

Enables Gentran Integration Suite to send SOAP messages. SendSOAPRequest SendSOAPRequest 
Business Process

Extracts EDI documents from an ANSI X12 
interchange-level envelope and locates an associated 
contract, according to the content of the documents. 
X12Deenvelope then starts the appropriate business 
process. 
With additional configuration, X12Deenvelope can also 
reconcile TA1 and 997 reports and generate the interchange 
TA1 and functional group 997 acknowledgments.

X12Deenvelope EDI Deenvelope Business 
Process

Business Goal Business Process For More Information, 
See
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ACHDeenvelope Business Process
The following figures show the Achdeenvelope business process model as it displays in the GPM:

The following BPML code makes up the Achdeenvelope business process:
<process name="ACHDeenvelope">
  <rule name="BPOnError">
    <condition>InvokeBPOnError/text()='YES'</condition>
  </rule>

  <rule name="PostProcess">
    <condition>InvokePostProcessBP/text()='YES'</condition>
  </rule>

  <sequence>
    <assign to="NACHA-Interchange" from="PrimaryDocument/@SCIObjectID"></assign>
    <operation name="ACHDeEnvelope">
      <participant name="DeenvelopeACH"/>
      <output message="Xout">
        <assign to="." from="*"></assign>
      </output>
      <input message="Xin">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <choice>
      <select>
        <case ref="PostProcess" activity="PostACHDeEnvelope"/>
      </select>

      <sequence name="PostACHDeEnvelope">
        <operation>
          <participant name="InvokeSubProcessService"/>
          <output message="Xout">
            <assign to="INVOKE_MODE">INLINE</assign>
            <assign to="WFD_NAME" from="//SuccessBPName/text()"></assign>
          </output>
Sterling Commerce, Inc. 85



ACHEnvelope Business Process
          <input message="Xin">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </sequence>
    </choice>
    <onFault>
      <choice>
        <select>
          <case ref="BPOnError" activity="ErrorBP"/>
        </select>
<sequence name="ErrorBP">
          <operation>
            <participant name="InvokeSubProcessService"/>
            <output message="Xout">
              <assign to="INVOKE_MODE">INLINE</assign>
              <assign to="WFD_NAME" from="//ErrorBPName/text()"></assign>
            </output>
            <input message="Xin">
              <assign to="." from="*"></assign>
            </input>
          </operation>

        </sequence>
      </choice>
    </onFault>
  </sequence>
</process>

Before Using the AchDeenvelope Business Process
Before you use the ACHDeenvelope business process, complete the following tasks:

1. Activate your license for the ACHDeenvelope service. 
2. Create an ACH-CTX inbound envelope. 

ACHEnvelope Business Process
The ACHEnvelope business processes performs the following primary activities:

1. Starting with one or more EDI documents, the ACHEnvelope services applies CTX envelope 
properties at the document level to each document, and then applies a message group header and trailer 
for documents with CTX Rule requirements.

2. The ACHEnvelope service takes one or more transaction sets and applies a functional group envelope.
3. The ACHEnvelope service takes a functional group and applies the interchange-level envelope and 

searches for a matching contract.
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4. Using the interchange-level envelope data, the service either looks up a contract or runs a business 
process.

The following figures show the ACHEnvelope business process model as it displays in the GPM:

The following BPML code makes up the AchEnvelope business process:
<process name="ACHEnvelope">
  <rule name="contract">
    <condition>CONTRACT_FOUND = &quot;YES&quot;</condition>
  </rule>

  <sequence>
    <sequence>
      <operation>
        <participant name="EnvelopeACH"/>
        <output message="Xout">
          <assign to="." from="*"></assign>
        </output>
        <input message="Xin">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <onFault>
        <operation>
          <participant name="BPExceptionService"/>
          <output message="Xout">
            <assign to="exceptionCode" from="'Translation Error'"></assign>
          </output>
          <input message="Xin">
          </input>
        </operation>

      </onFault>
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      <onFault code="Translation-Error-Some-Docs">
        <assign to="BREAK">YES</assign>
      </onFault>
    </sequence>
    <choice>
      <select>
        <case ref="contract" activity="invoke_contract_workflow"/>
      </select>

      <sequence name="invoke_contract_workflow">
        <operation>
          <participant name="InvokeBusinessProcessService"/>
          <output message="Xout">
            <assign to="INVOKE_MODE">ASYNC</assign>
            <assign to="." from="*"></assign>
          </output>
          <input message="Xin">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </sequence>
    </choice>
  </sequence>
</process>

Before Using the ACHEnvelope Business Process
Before you use the ACHDeenvelope business process, complete the following tasks:

1. Activate your license for the ACHenvelope service.
2. Create an ACH-CTX inbound envelope.

EDI Deenvelope Business Process 
The EDI Deenvelope business process includes the EDI Deenveloping service to support non-printable 
characters as EDI delimiters and perform the following steps:

1. Splits documents into interchanges and puts delimiters sent in the ISA (or UNA) into process data.
2. Starts the X12 Deenveloping, EDIFACT Deenveloping, or CII Deenveloping business processes, as 

appropriate.

If exceptions occur when running an EDI Deenvelope business process, Gentran Integration Suite generates 
an EDI Compliance Report.
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The following figure shows the EDI deenveloping business process model as it displays in the GPM:

The following BPML code makes up the EDI deenveloping business process:
<process name="EDIDeenvelope">
  <sequence>
    <operation>
      <participant name="EDIDeenvelope"/>
      <output message="Xout">
        <assign to="." from="*"></assign>
      </output>
      <input message="Xin">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>

The following scenario shows how the EDIDeenvelope business process can deenvelope ANSI X12 
documents:

1. The File System adapter collects a file from an ANSI X12 collection folder and invokes the 
EDIDeenvelope business process.

2. The EDI Deenveloping service determines that the file contains an X12 document and starts the 
X12Deenvelope business process.

3. The X12Deenvelope business process removes the envelopes to make available the transaction set 
envelope for the X12 document and determine the next action to perform.

4. For documents with CII Syntax Rule requirements, the X12Deenvelope business process parses the 
message group and uses the values indicated in the message group header to locate a matching 
envelope. The envelope then determines the next action to perform. 

Note: If the X12Deenvelope business process does not locate a matching envelope, the business process 
stops. Gentran Integration Suite generates an EDI Compliance Report that describes the reason that 
the X12Deenvelope business process could not locate the envelope.

Before Using EDIDeenvelope
Before you use the EDIDeenvelope business process, you must complete the following tasks:

1. Create the trading profile, including a contract.
2. Create necessary envelopes.
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3. Create a business process that initiates the EDIDeenvelope business processes.
When creating a business process that enables inbound ST (or UNH) envelopes to translate 
transactions when running EDIDeenvelope business processes, consider:

Delimiters sent in the ISA or UNA segments are placed into process data in Gentran Integration 
Suite.

The GPM makes available parameters that represent the delimiters, which you must configure to 
enable the envelopes to translate transaction.

You must create an XPath expression that describes the location of envelopes and apply it to the 
Translation service. 

OverdueAckCheck Business Process 
The OverdueAckCheck business process identifies EDI documents that are waiting for an acknowledgment. 
Most likely, an acknowledgment is overdue when an EDI document state indicates continuous waiting. 
OverdueAckCheck produces a status report that lists details about EDI documents. You can use the report 
to determine whether an acknowledgment is overdue.

The following figure shows the OverdueAckCheck business process model as it displays in the GPM:

The following BPML code makes up the OverdueAckCheck business process:
<process name="OverdueAckCheck">
  <sequence>
    <operation>
      <participant name="OverdueAck"/>
      <output message="Xout">
        <assign to="." from="*"></assign>
      </output>
      <input message="Xin">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>

Before Using OverdueAckCheck
Before you use the OverdueAckCheck business process, you must specify in the envelope configuration that 
you expect an acknowledgment.
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HandleSOAPRequest Business Process 
The HandleSOAPRequest business process enables Gentran Integration Suite to receive SOAP messages. 
When HandleSOAPRequest receives a SOAP message, HandleSOAPRequest validates the message, and 
then reads the message to determine the receiver of the message. 

If Gentran Integration Suite is the receiver of the message, HandleSOAPRequest performs this process:

1. Verifies the digital signature. 
2. Removes the SOAP envelope and puts any attachments and SOAP header blocks into process data. 

Gentran Integration Suite puts inbound SOAP message attachments in business process data under the 
node SOAPRequestAttachments. The attachments follow this naming convention: SOAPAttachment1, 
SOAPAttachment2, and so on. Gentran Integration Suite sets the content ID attribute to what was 
specified in the SOAP message.

3. Invokes indicated subprocesses. 
4. Applies a SOAP envelope if necessary and HTTP headers to the document.
5. Returns a response to requestor.

If Gentran Integration Suite is not the ultimate receiver, HandleSOAPRequest performs this process:

1. Verifies the digital signature.
2. Removes SOAP header blocks that are specific to Gentran Integration Suite and puts them into process 

data.
3. Invokes indicated subprocesses.
4. Forwards a document to the next receiver.
5. Receives a response from the receiver.
6. Returns a response to the requestor. 
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The following figures show the HandleSOAPRequest business process model as it displays in the GPM:

The following BPML code makes up the HandleSOAPRequest business process:
<process name="HandleSOAPRequest">
  <rule name="acting_as_intermediate">
    <condition>SOAP_INTERMEDIATE_NODE = &quot;true&quot;</condition>
  </rule>

  <rule name="acting_as_endpoint">
    <condition>SOAP_INTERMEDIATE_NODE = &quot;false&quot;</condition>
  </rule>

  <sequence>
    <sequence>
      <operation name="SoapIn">
        <participant name="SOAPInbound"/>
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        <output message="output">
          <assign to="." from="*"></assign>
        </output>
        <input message="input">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <choice>
        <select>
          <case ref="acting_as_intermediate" activity="act_as_intermediate"/>
        </select>

        <sequence name="act_as_intermediate">
          <assign to="xport-http-url" from="NextSoapURL/text()"></assign>
          <sequence>
            <operation name="HTTP Client Begin">
              <participant name="HTTPClientBeginSession"/>
              <output message="HttpClientBeginServiceInputMessage">
                <assign to="." from="PrimaryDocument"></assign>
                <assign to="RemoteURL" from="xport-http-url/text()"></assign>
                <assign to="HTTPClientAdapter">HTTPClientAdapter</assign>
              </output>
              <input message="inmsg">
                <assign to="." from="*"></assign>
              </input>
            </operation>
<operation name="HTTP Client Post">
              <participant name="HTTPClientPost"/>
              <output message="HttpClientPostServiceInputMessage">
                <assign to="." from="PrimaryDocument"></assign>
                <assign to="SessionToken" from="SessionToken/text()"></assign>
                <assign to="RawResponse">true</assign>
                <assign to="RawRequest" 
from="xport-force-b2b-raw-message/text()"></assign>
              </output>
              <input message="inmsg">
                <assign to="." from="*"></assign>
              </input>
            </operation>

            <operation name="HTTP Client End">
              <participant name="HTTPClientEndSession"/>
              <output message="HttpClientEndServiceInputMessage">
                <assign to="SessionToken" from="SessionToken/text()"></assign>
              </output>
              <input message="inmsg">
                <assign to="." from="*"></assign>
              </input>
            </operation>

            <onFault>
              <sequence>
                <operation name="HTTP Client End">
                  <participant name="HTTPClientEndSession"/>
                  <output message="HttpClientEndServiceInputMessage">
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                    <assign to="SessionToken" from="SessionToken/text()"></assign>
                  </output>
                  <input message="inmsg">
                    <assign to="." from="*"></assign>
                  </input>
                </operation>

                <assign to="SOAPfaultcode">Server</assign>
                <assign to="SOAPfaultstring">There was an error processing the SOAP 
request.</assign>
                <assign to="SOAPdetail">An error occurred trying to send SOAP request 
to next node.</assign>
              </sequence>
            </onFault>
          </sequence>
          <operation name="SoapIn">
            <participant name="SOAPInbound"/>
            <output message="output">
              <assign to="." from="*"></assign>
              <assign to="bootstrap">false</assign>
            </output>
            <input message="input">
              <assign to="." from="*"></assign>
            </input>
          </operation>
<assign to="SOAPOutboundAttachments" from="SOAPResponseAttachments/*"></assign>
        </sequence>
      </choice>
      <choice>
        <select>
          <case ref="acting_as_endpoint" activity="act_as_endpoint"/>
        </select>

        <sequence name="act_as_endpoint">
          <operation>
            <participant name="InvokeBusinessProcessService"/>
            <output message="Xout">
              <assign to="." from="*"></assign>
              <assign to="INVOKE_MODE">SYNC</assign>
            </output>
            <input message="Xin">
              <assign to="." from="*"></assign>
            </input>
          </operation>

          <onFault>
            <sequence>
              <assign to="SOAPfaultcode">Server</assign>
              <assign to="SOAPfaultstring">There was an error processing the SOAP 
request.</assign>
              <assign to="SOAPdetail">An error occurred while processing the SOAP 
request.</assign>
            </sequence>
          </onFault>
        </sequence>
      </choice>
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      <onFault code="SOAP-FAULT">
        <assign to="InvokeSubBP">false</assign>
      </onFault>
    </sequence>
    <operation name="SoapOut">
      <participant name="SOAPOutbound"/>
      <output message="output">
        <assign to="." from="*"></assign>
        <assign to="SOAP_MODE">respond</assign>
      </output>
      <input message="input">
        <assign to="." from="*"></assign>
      </input>
    </operation>
<assign to="doc-has-headers">true</assign>
    <operation name="HttpResponse">
      <participant name="HttpRespond"/>
      <output message="Xout">
        <assign to="." from="*"></assign>
      </output>
      <input message="Xin">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>

Before Using HandleSOAPRequest
Before you use the HandleSOAPRequest business process, you must complete the following tasks:

✦ Configure the SOAP Inbound service.
✦ Configure a related B2B HTTP Server adapter so that it is configured for raw messages, has the same 

URI as the SOAP Inbound service, and is associated with the HandleSOAPRequest business process.
✦ Create the business process that processes the SOAP message where Gentran Integration Suite is the 

final receiver. Depending on your needs, you may need to assign values to several parameters before 
using the HandleSOAPRequest business process.
The following table identifies parameters for various SOAP functions and the values you must specify: 

 

Required SOAP Function SOAP Parameter Parameter Values

SOAP enveloping on primary document 
before posting

ADD_SOAP_ENVELOPING True = add SOAP enveloping (default).

Digitally sign a SOAP message SIGN_WITH_KEY Type the exact name of the digital 
certificate.

Envelope namespace prefix for SOAP 
message

SOAPEnvNSPrefix Type the envelope namespace prefix. 
ADD_SOAP_ENVELOPING must also be 
true.
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SendSOAPRequest Business Process 
The SendSOAPRequest business process enables Gentran Integration Suite to send SOAP messages. 

When Gentran Integration Suite sends a SOAP message, SendSOAPRequest performs the following 
process:

1. Applies a SOAP envelope to the data, if requested.
2. The SendSOAPRequest business process adds SOAP headers to an outbound request if the process 

data contains SOAP headers. The business process takes all subordinate nodes under the 
SOAPHeaders node in process data and adds them as SOAP header blocks.

3. The SendSOAPRequest business process adds SOAP attachments to an outbound request if the 
process data contains SOAP outbound attachments. The business process takes all subordinate nodes 
under the SOAPAttachments node, which are named SOAPAttachment1, SOAPAttachment2, and so 
on. These nodes must have a ContentID attribute specified, as well.

4. Sends the SOAP message to a receiver using HTTP.
5. Receives a response.
6. Acknowledges a response.
7. Provides a response to another business process in Gentran Integration Suite.

The following figures show the SendSOAPRequest business process model as it displays in the GPM:

Distinguish whether expected response 
is a SOAP message

RESPOND_NON_SOAP True = response is not a SOAP message.
False = response is a SOAP message.

Envelope namespace for SOAP 
message

SOAPEnvNSURI Type the envelope namespace.

Required SOAP Function SOAP Parameter Parameter Values
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The following figure continues the business process model of the SendSOAPRequest business process:

The following BPML code makes up the SendSOAPRequest business process:
<process name="SendSOAPRequest">
  <sequence>
    <operation name="SoapOut">
      <participant name="SOAPOutbound"/>
      <output message="BPML:output">
        <assign to="." from="*"></assign>
      </output>
      <input message="input">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <sequence>
      <operation name="HTTP Client Begin">
        <participant name="HTTPClientBeginSession"/>
        <output message="HttpClientBeginServiceInputMessage">
          <assign to="." from="PrimaryDocument"></assign>
          <assign to="RemoteURL" from="xport-http-url/text()"></assign>
          <assign to="HTTPClientAdapter">HTTPClientAdapter</assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <operation name="HTTP Client Post">
        <participant name="HTTPClientPost"/>
        <output message="HttpClientPostServiceInputMessage">
          <assign to="." from="PrimaryDocument"></assign>
          <assign to="SessionToken" from="SessionToken/text()"></assign>
          <assign to="RawResponse">true</assign>
          <assign to="RawRequest" from="xport-force-b2b-raw-message/text()"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>
<operation name="HTTP Client End">
        <participant name="HTTPClientEndSession"/>
        <output message="HttpClientEndServiceInputMessage">
          <assign to="SessionToken" from="SessionToken/text()"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
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      </operation>

      <onFault>
        <sequence>
          <operation name="HTTP Client End">
            <participant name="HTTPClientEndSession"/>
            <output message="HttpClientEndServiceInputMessage">
              <assign to="SessionToken" from="SessionToken/text()"></assign>
            </output>
            <input message="inmsg">
              <assign to="." from="*"></assign>
            </input>
          </operation>

        </sequence>
      </onFault>
    </sequence>
    <operation name="SoapIn">
      <participant name="SOAPInbound"/>
      <output message="BPML:output">
        <assign to="." from="*"></assign>
        <assign to="bootstrap">false</assign>
      </output>
      <input message="input">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>

Before Using SendSOAPRequest
Before you use the SendSOAPRequest business process, you must complete the following tasks:

✦ Configure the SOAP Outbound service. 
✦ Create a separate business process for each SOAP service you want Gentran Integration Suite to call. 

The business process must complete the following tasks:

Assign a value to SOAPRequestURL. The value is the URL to which Gentran Integration Suite 
should post the SOAP request.

Perform an operation with InvokeBusinessProcessService as the participant, assigning 
SendSOAPRequest to the WDF_NAME parameter.
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✦ Depending on your needs, you may need to assign values to other parameters before using the 
SendSOAPRequest business process. 
The following table identifies parameters for various SendSOAP functions and the values you must 
specify: 

Required SOAP Function SOAP Parameter Parameter Value

SOAPAction HTTP header must be 
present

SOAP_ACTION Type the HTTP header.

SOAP enveloping on primary document 
before posting

ADD_SOAP_ENVELOPING True = add SOAP enveloping (default).
False = no SOAP enveloping.

Digitally sign a SOAP message SIGN_WITH_KEY Type the exact name of the digital 
certificate. 

Envelope namespace prefix for SOAP 
message

SOAPEnvNSPrefix Type the envelope namespace prefix. 
ADD_SOAP_ENVELOPING must also 
be true.

Distinguish whether expected response 
is a SOAP message

SOAP_RESPONSE_NON_
SOAP

True = response is not a SOAP 
message.
False = response is a SOAP message.

Verify a SOAP response that has been 
digitally signed

VERIFY_WITH_KEY Type the name of the public key. Specify 
this value before you use the 
SendSOAPRequest business process if 
you expect a signature on the SOAP 
response.

Must use a proxy server xport-tp-proxyauth Type the following information in this 
format: IP address,port number,user 
name,password.
User name and password may not be 
required.

Envelope namespace for SOAP 
message

SOAPEnvNSURI Type the envelope namespace.
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